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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide.
The Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform
insurance rating and underwriting technology solution that provides integrated management for
every aspect of the rate definition and modification process. This guide will help with the
installation of the Insbridge Rating and Underwriting System.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

Windows Only Installation

o Full RateManager Installation — This installation will install RateManager and the
Insbridge Framework Administrator (IBFA). This is for a Windows only environment,
using a SQL Server database.

o SoftRater Node Installation — This installation is for existing environments that want to
add a Windows SoftRater node to an environment.

o Database — Incorporating an Oracle Database in a Windows Environment.

Incorporating a Java Environment

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using a SQL Server database.

o Full SoftRater Installation on a Java Machine — This installation will install SoftRater
on a Java machine, using an Oracle database.

Upgrading

o Upgrade — This installation is for existing customers and will take their current version of
IBRU up to version 04.01.00.

This guide will describe a Windows Only installation, Incorporating an Oracle Database
and Upgrading.
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E-Delivery

The Insbridge Rating and Underwriting (IBRU) System is available as a download from the Oracle
E-Delivery system. Downloaded files are zipped. Prior to installation, please make sure the
source machine(s) where IBRU will be loaded has an unzip utility. An unzip utility for most
platforms is available on the E-Delivery download page.

Documentation from E-Delivery is in PDF format. Prior to installation, please make sure the
source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers
you have downloaded and the corresponding file name. You may be asked to provide the part
numbers or the filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge IBRU Install — This is required for all installations

SoftRater for WebSphere — This is required if you are using WebSphere

SoftRater for WebLogic — This is required if you are using WebLogic

SoftRater for Jboss — This is required if you are using Jboss

Documentation — It is recommended that you download the documentation. Installation

guides and user guides are located here.

The Insbridge IBRU install is required for all installations.

The 04.01-Insbridge-IBRU folder contents:

- Databases
Oracle

- SoftRater — IBSR

o

Usp_IBSR_v03.12.0.oracle

SQL Server
- RateManager — IBRM

o

@)

Latin1_General_BIN

= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
SQL_Latin1_General_CP1_CI_AS

= DATABASE_BACKUP_IBRM_TEMPLATE.bak

- Security — IB_CLIENT

@)

SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

- SoftRater — IBSR

o

O
- |E7 Users

Latin1_General BIN

= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
SQL_Latin1_General CP1_CI_AS

= DATABASE BACKUP_IBSR_TEMPLATE.bak

Usp_ IBSR v03.13.0.sql

Insbridge IE7 Active X Control Update PDF
RateManager_|E7.exe
- Oracle Bl Publisher
OBI_PUBLISHER.exe
- Oracle Client
Oracle_client.exe
- Oracle Insurance — Insbridge Rating and Underwriting.exe
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You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you
want. Everything for a Windows only installation is in the 04.01.00-Insbridge-IBRU folder. If you
want to incorporate a Java environment, please download the corresponding SoftRater file.
SoftRater downloads are not required if you are running in Windows only.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

IBRU — Insbridge Rating and Underwriting System. This is the entire system.

IBFA — Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS - Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

SoftRater Native — SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

RM — RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

SR — SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

SR-WIN — SoftRater for Windows. This is also another name for IBFA.

SR-JAVA - SoftRater for Java. This is also another name for IBSS.

SRP — SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

VFES — Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.
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Physical Environment — A physical environment is generally referred to as a physical
machine.

Authoring Environment — The physical machine where RateManager is installed.

Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other
supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for

Hardware and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Edition Zubllcatlon Prod.uct Publication Date Comment
umber Version

1% Edition P01-701-01 03/28/2005 Updated for new layout /
Windows 2003

2" Editon ~ P01-701-02 04/14/2005 New layout, updated
ASPNET user permissions
req

3 Editon  P01-701-03 V3.6 03/14/2006 Update

4" Editon ~ P01-701-04 V3.7 09/28/2006 Update

5" Editon  P01-701-05 V3.8 July 2007 Update

6" Editon  P01-701-06  V 3.8.3 October 2007 Update

7" Editon  P01-701-07 V 3.8.5 November 2007  Update

8" Editon  P01-701-08  V 3.8.7 January 2008 Update

9" Editon  P01-701-09 Vv 3.8.8 March 2008 Update

10" Editon  P01-701-10 V3.9 May 2008 Update

11" Editon P01-701-11  V 3.10 September 2008  Update

12" Edition  P01-701-12 V 3.1 December 2008 Update

13" Editon  P01-701-13  V 3.12 July 2009 Update

14" Editon  P01-701-14  V 3.13 December 2009  Update

15" Editon  P01-701-15 R 4.0 April 2010 Update

16" Editon P01-701-16 R 4.0.1 August 2010 Update Release
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17" Editon  P01-701-17 R 4.1 December 2010  Update
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Chapter 1
PLANNING YOUR IBRU SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added later
on. The Oracle Insurance Insbridge Rating and Underwriting system (IBRU) is expandable and can
accommodate a few different configurations.

Databases

RateManager and IBFA require a SQL Server database. RateManager and IBFA can utilize either SQL
Server 2005 SP/2 or 2008 SP/1. SoftRater can use a SQL Server 2005 SP/2 or 2008 SP/1 database, an
Oracle 10g or 11g database or an IBM DB2 v9.1 database or a combination of databases. SQL Server
can be the only database system used. No other database system is required; however another database
system can be used if you want.

For the examples in this guide, physical environments that use SQL Server will have one database per
environment. For Oracle or DB2, QA and Production will share a database.

For use in this installation guide, SQL Server will refer to either SQL Server 2005 SP/2 or 2008 SP/1.
Differences between SQL Server 2005 SP/2 and 2008 SP/1 will be pointed out where they occur.

NOTE: While it is possible to have RateManager, IBFA and SQL Server all on the same machine, it is not
recommended due to performance and security issues. This option will not be discussed in this
document.

Physical Environments

A physical environment generally refers to a physical machine where a specific activity is performed. For
example, a physical environment called development could be created where users only create rating
programs. Another physical environment called QA could be where users only test ratings. There is no
limit to the number of physical environments you can have.

It is recommended that three physical environments be setup; one for development, one for testing or
quality assurance (QA) and one for production.

o Development — this environment holds RM and an IBFA instance on the same Windows Server
machine and will utilize a SQL Server database. This environment is most often used for the
creation of rating and underwriting logic. Once development is complete, SRPs will be copied into
a QA environment.

¢ QA —this environment can contain either an IBFA instance or an IBSS instance, depending upon
the database and machine to be used. If a Windows machine is used, an IBFA instance will be
installed. If a Java machine is used, an IBSS instance will be installed. This environment is most
often used for the testing of SRPs prior to being placed into Production. Once testing is complete,
SRPs will be copied to production.
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e Production — this environment can contain either an IBFA instance or an IBSS instance,
depending upon the database and machine to be used. If a Windows machine is used, an IBFA
instance will be installed. If a Java machine is used, an IBSS instance will be installed. This
environment is most often used for rating.

Authoring Environment

The authoring environment is the physical machine where RateManager is installed. This machine must
be a Windows Server machine and must utilize a SQL Server database.

Although it is possible to have more than one authoring environment, it is recommended that only one
authoring environment be setup in development.

Rating Environments

The rating environment is comprised of the physical machines where SoftRater is installed. You can have
multiple machines in a rating environment.

One rating environment should be setup encompassing testing or quality assurance (QA) and production.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 14



IBRU Environments
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( Environments — Physical, Authoring, Rating and Logical

Databases
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PURPOSE of this Authoring
Environment

This erviranment is for the
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This emvironment is for the testing of packs
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of multiple logica
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Logical Environments

A logical environment is an environment created for a subscriber in IBFA or IBSS. This environment is
used for rating and/or SoftRater package (SRP) management. The logical environment defines package
location, engine location and database location in addition to several other supporting data items.

When you create logical environments, you enter the package storage locations. These are the system
folders where SoftRater packages (SRP) are stored. When an SRP is created, the file is stored in the
folder location configured in the environment that the package was created for.

When a program is ready to go from development to the QA environment, the SRP will be placed in the
folder location that was designated for the logical environment selected. An SRP can be copied from one
logical environment to another from the SRP listing screen in IBFA. SRP’s can also be copied from a
different physical machine (that has IBFA installed) by creating a Virtual File Server.

In a Java environment, the rating environment IBFA will handle the copying and loading. No Virtual File
Server will be created. IBFA does the package management and migration. This can only be performed
by IBFA. Java environments are for rating only.

You can create as many logical environments as you want to manage.

It is recommended that at least two logical environments be configured in IBFA, one for RateManager and

one to represent the QA environment and folder location of the SRPs. It is recommended that at least one
logical environment be setup in testing or quality assurance (QA) and one for production.
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A Windows Only Environment Example:

IBRU Installation/Setup — Windows/SQL Server

( Environments — Physical and Logical

SQL Server

Must be the same
in all enviranments

ADD
DB Connections:

Controller
Security
RM

CREATE:

Logical
Environments:

RM - to handle
testing/rating.

QA_SR - This
environment
contains the full
packages (o ba
consumed by QA

~

PURPOSE of this Physical
Environment

This erwvironment is for the
creation of rating programs.

This environment also holds the
sacurity Information,

IB_CLIENT
security
Restore
o SGL
Sarver

RM
This
|IERM DB

holds Rating &
Rules

Development QA Production
Raﬂﬁtz;fi:;u'es Test Rating Production Rating
INSTALL: INSTALL: INSTALL:
IBR;A IBFA IBFA
OB Publisher 0Bl Publisher OBl Publisher
CREATE CREATE CREATE
SUBSCRIBER SUBSCRIBER SUBSCRIBER

Must be the same
in all emvironments

CREATE:

Logical
Environments:
SR — o identify the
location of the

lecal SRPs and
the QA IBSR DB.

"

CREATE:
VFS:

Taothe QA_SR
environment on
the Developgment
machine

PURPOSE of this Physical
Environment

This environment is for the testing
of packages (SRPs).

SR
Restore This IBSR OB
o S0L halds SREPs for
Sarvar thes tast

environment

Must be the same
In all ermvironments

CREATE:

Logical

Enviranmenis:

SR - to identify the
location of the
local SRPs and
the Preduction
IBSR DB.

~

CREATE:

WFs:

To the SR
environment on
the QA machine

PURPOSE of this Physical
Environment

This environment is for (real-time)
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send rate requests through the
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Production_SR
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This example has three physical environments each with its own application machine and database
machine. It is possible to put all SQL Server databases on one database machine or divide over two
machines. If you select to use one or two SQL Server database machines, clear and precise naming of
the associated databases is recommended.

RateManager and IBFA must run on a Windows Server machine. No other operating system will be
required. RateManager will be installed on the Development machine only.

NOTE: While it is possible to have RateManager, IBFA and the database server all on the same
machine, it is not recommended due to performance and security issues. This option will not be
discussed in this document.

The setup for this example is:
1. All three instances of IBFA will need to be configured the same.

2. In the Development environment:
a. RateManager and IBFA/SR-WIN would be located on the same Windows machine.
b. On the IBFA/SR-WIN for this environment, three database connections would be created
and two logical environments would be created.
c. Two databases would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 23.

3. Inthe QA environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
c. One database would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 59.

4. Inthe Production environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
c. One database would be restored to a separate SQL Server machine.

An example of this environment setup/installation is on page 59.

You can add another environment if necessary. For example, if you wanted to create a training
environment or a second level of testing, you could add these environments in where you wanted.

There are other combinations of application servers and databases that you can use. Please contact your
Insbridge representative for more information on the configuration that you would like to have.

NOTE: For the examples in this guide, the QA and Production environments will be exactly alike to allow
for true QA standards.
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Chapter 2
SYSTEM REQUIREMENTS

Server Requirements

A full installation of Microsoft Windows Server is required for IBFA/SR-WIN and RateManager
installations. IBRU installers should be familiar with managing a Windows server. For help with verifying
or installing required components, please see Windows 2003 Settings and Permission Notes on page
122. For a 64-bit machine, please see Insbridge Installation for 64-bit.

Required Components

The following components are required:

e Microsoft .NET Framework version 3.5

e IS —Internet Information Services version 6.0 or 7.0

e For Windows 2008 Server — WCF http activation needs to be enabled
¢ MSMQ — Microsoft Message Queuing Services — basic functionality only.

o JRE -Java Runtime Environment (not required for a SoftRater Node only install)

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

Microsoft SQL Server

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the IBRU web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.
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If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

o Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latin1_General_CP1_CI_AS and sort order plus case sensitivity using Latin1_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latin1_General_CP1_CIl_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
questions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.

Special Considerations for SQL Server in a Java Setup

For Java setups only when connecting to SQL Server from IBSS:
e For New Installations: No action is required.
e For Upgrades: If you want to keep the current Environment settings that are in IBSS, there are
additional steps that need to be performed. Please see the SQL Server Upgrade chapter in the

corresponding SoftRater Installation Guide for the exact steps.

If you are running a Windows only environment, no additional steps will be required. This is only for
SoftRater for WebLogic, SoftRater for WebSphere and SoftRater for JBoss.

Default SQL Server Database User Roles and Permissions Required

If a more granular approach is required for management of security of the IBRU databases, then the
following guidelines can be used to set the required permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Rating and Underwriting System will fail. An experienced database administrator’'s expertise is
highly recommended before making any security changes.

o IBSR Database User — Account requires database owner (DBO) access to the IBSR databases
because new tables will be created in the SoftRater (IBSR) database dynamically when or if a
new line of business SRP (SoftRater Package) is loaded to the SoftRater system.

o IBRM_xxxx and IB_CLIENT Database User — Account requires execute access against the
Insbridge stored procedures and full access to the Insbridge schema.
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INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed. This user needs to be a member of the User group and requires certain privileges in order to
fully control the entire IBRU environment. For ease of installation and if the server is dedicated to the
Insbridge Rating and Underwriting System, it is suggested that this user be added to the local machine
Administrators group.

If the installer has permissions, an Insbridge user can be created during the installation.

To create a new user:

Right click the My Computer icon on the desktop.
Select Manage from the drop down list.

Select Local Users and Groups.

Select Users.

Right click on the right side of the screen.

Select New User.

(=) Computer Management Q@E|

o0k wN =~

g File  Action  Wiew  Window  Help ;lilJ
& f=a B ®
=) Computer Management (Local) Mame Full Name Descriptian
= m System Tools lg.fltclrnil'uistratnr Built-in account For administering the. ..
Bvent Viewer F\SF‘NET ASP.MET Machine Account Account used For running the ASP.I. ..
% Shared Folders Guest Built-in account For quest access ko k...
= grs and Groups %Helpnssistant Remate Desktop Help Assi,..  Account For Providing Remaote Assist, ..
[:l Groups ILISR_PLQ.D.D... Inkernet Guest Accounkt Built-in account For anonymous acce, ..
| Performance Logs and Alert: lgIW.ﬂ'.r\'1_PLIC;_I.\5'.. .. Launch II5 Process Account  Built-in account For Internet Informa. ..
E;. Device Manager Mary
=] Storage QSUF‘PORT_SS. . CM=Microsoft Corporation..,  This is a vendor's account For the He, .,
Remaowable Storage
Disk Defragmenter
Disk Management

& Services and Applications

Figure 1 Creating New User

7. Add a new Insbridge user. The Insbridge User should be assigned to the local Users group and
have the same permissions as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user

cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.
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Mew User E]E|

User name: |nzbridoe

Eull narne: [BRL User
Description: [BRL User
Pazgword: TTITIT L)
Confirm pazsword: LLLLLT L)

|lzer cannat change pazsward
FPazzword never expires
[ ] &ceount iz dizabled

Create I [ Cloze

Figure 2 Adding User information

8. Click Create. You can close out computer management. Please keep this information close at
hand. You will need it for the first installation.

To create a new user in Windows Server 2008:

Select Start->Administrative Tools—>Server Manager.
Select Configuration>Local Users and Groups.

Select Users.

Right click and select New User. Add an Insbridge User.
Click OK.

aorODN -

Insbridge User Password
The password can be set to any password that meets your company standards. The IBRU administrator
must make note of the password for future configuration.

For ease of maintenance, the IBRU user should not have to change the password and the password
should never expire.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries after you change your password. The installation will
automatically apply the Insbridge user name and password to the necessary libraries. If you
change the password, you will have to change the password in all three of the Insbridge Com+
libraries. On each library, right click, select Properties, select the Identity tab, and enter in the new
password.
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Chapter 3

FULL RATEMANAGER INSTALLATION

This installation will install RateManager and the Insbridge Framework Administrator (IBFA). This is for a

Windows only environment, using a SQL Server database.

Before installing, please verify that the system requirements
are in place. Development
Rating anq Rules
The installation should be performed in the following order: futhering
1. Install the IBRU application. INSTALL:
2. Registry Access. N
QBI Publisher
a. Assigning Insbridge Access. —
b. Exporting Key for safe keeping. ESCRIBER
in all environments
3. Assigning permissions to the Insbridge User for the
Windows Temp Folder. This is necessary for MSMQ ADD
DB C tions:
4. Assigning permissions to the Insbridge User for the et
Insbridge Folder Cs?:ct[.ﬂ'r‘:'
RM
5. Creation of the IBRU databases is next. There are two
databases that must be in place.
CREATE:
a. IB_Client .
- Logical
b |BRM Environments:
RM — to handle
6. Return to IBFA and Configure: 5 tesling'rating.
a. Create your subscriber. E" Convirorment.
contains the full
b. Add database connections. 2 packages o be
o consumead by QA
c. Create your logical environments. E -
w
Verifying Component Services. 5
Allowing for WCF Activation. FOR WIN 2008 ONLY. | PR oo pvsical
c
Install OBI Publisher. 2 This enviranment is for the
= creation of rating programs
10. Login to RateManager and perform IBRU database |2 This envirenment alsa holds the
updates. u:é_l sacurty Information,
g SEEECELELEC LT LRLEE e L e
For a Windows 2008 Server installation, you must run as 5 CLIENT
Administrator. security
@
el bear
w Sarver =
- g
g IBQ‘I'SDB
holds Rafing &
Rules.
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

i'g!;!' Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B |

4 Oracle Insurance Insbridge Rating and Underwriting

[tiz strongly recommended that you exit all Windows programs befare running this setup program.

Click Cancel to quit the zetup pragram, then cloze any programs pou bave running. Click Mest to
continue the installation.

WARMIMG: Thiz program iz protected by coperight law and international treaties.

Ilnauthorized reproduction or distnbution of thiz program, or any portion of it, may result in severe civil
and criminal penalties, and will be prozecuted to the masimunm extent pozsible under law.

ORACLE

INSURANCE

Cancel |

Figure 3 Installing Insbridge

3. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The “Wize Installation “izard will inztall the files far Oracle Insurance - Inzbridge Bating
and Lndenwriting in the following folder.

To ingtall into a different folder, click the Browse button, and zelect another folder.
'ou can choose not ba install Oracle Insurance - Insbridge B ating and Undenwriting by
clicking Cancel to exit the ‘Wize Installation *izard.

Drestination Folder
{E:'&F‘HDGH.&M FILESSORACLENGEUMMSERIDGEY

Wize Inztallation YWizard [R]

Figure 4 Entering the Destination Folder for Insbridge

4. Choose the location where the Insbridge installation will be located. This will be the location for all
future installations for Insbridge applications. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Logon Information DRACLE‘

The following logon information is uzed by Inshbridge. INSURANCE

Specify a uzer account ba be uzed by the application, either far running a service ar for
logging onto other serverz. Uze the Browse button to chooze wzers from pour nebwaorl.
Faor damainz, user names must be in the format of DOMAINW seM ame.

User M ame: |Insl:uriu:|ge Browsze. .. |

Pazzwiord: Ixxxxxx,mﬁ

Create Mew Lzer. . |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 5 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 21.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Select Features C}RACLE‘

Pleaze select which features you would like to install. INSURANCE

Feature Description:

Oracle Insurance Inzbridae B ating and
IIndenariting iz a Web-bazed rating, riles, and
underwriting syzten,

Thiz feature will be installed an the lacal hard
drive.

Thiz feature requirez OKB on vour hard drive. 1t
has 2 af 2 subfeatures selected. The subfeat. ..

Current location:
C:%\PROGRAKM FILESYORACLENGEUNNSERIDGE®

Wize Inztallation YWizard [R]

Dizk Cost Beset < Back | Hest » I Cancel

Figure 6 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that
you will be allowed to not install. Click Next to continue.

Options are:

o Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

o IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
- This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.
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i'él Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= E3 |

Ready to Install the Application ORACLE

Click Mext ta begin installation. INSURANCE

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

Wize Inztallation \wizard [R]

Cancel |

¢ Back

Figure 7 Ready to Install

8. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check
the options you want to install.

i,él Oracle Insurance - Insbridge Rating and Underwriting Setup M= BB |
Updating System ORACLE
The features you selected are currently being installed. INSURANCE

Yalidating inztall...

YWize Inztallation ‘wizard [R]

Figure 8 Installation Progress
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Readme Information DRACLE‘

|nzbridge has been successfully installed. INSURANCE

Microsoft Windows 2003/2008 Server o
A full installation of Microsoft Server 20032008 is required. The following
configuration assumes that the administrator of the senver to be generally
familiar with managing a Windows server. i

Internet Information Services (lI5)

The InsBridge Rating and Underwriting System is a web based application and
requires IS to be installed before installation to facilitate the default web virtual
directaries creations.

The subcomponents of IS needed by IBRL:

. Commaon Files
. Documentation
. Internet Information Serices Snap-In |

YWize [nstallation ‘wizard®

Figure 9 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Selecting Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

& Registry Editor

File Edit Wiew Favorites Help

= My Computer Mame Type | Data
-] HKEY_CLASSES_ROOT [ab](Default) REG_SZ {alue not set)
{2 HKEY_CURRENT_USER
B0 HKEY_LOCAL_MACHINE
- HARDWARE
- 5aM
(] SECURITY
- SOFTWARE
- Co7rsy
-] Classes
- Clients
- Gemplus
[ GHU
£
[

74
7] Installs  Expand
(] lameme  Hew L
H-(] Mcafee  Eind...

7-{_7] Microso

E
E

Delet
ECD Mozl
E
E
E

R
7-{_] MozilaF AN

#-{] Netwaor  Expor

-] ODBC T
{1 ordoEl
F-] Policies S0Py Key Name |
-{_] Pragram Graups
-{_] Schiumberger
(] Secure

-1 SYSTEM

{0 HKEY_USERS
{0 HKEY_CURRENT_CONFIG

|My ComputeriHKEY _LOCAL_MACHINE\SOFTWARE\Insbridge 4

Figure 10 Configure Registry Access Windows Server
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4. Right click and select Permissions.
Click Add.

6. On the Select Users or Groups popup, you can leave the defaults for the Object Types and
Locations or enter the values you require.

o

Select Users or Groups ﬂ

Select thiz object type:

ILlsers, Groups, or Buil-in security principals Object Topes...

Erarn thig location;
|WIN£—‘«F‘F‘EIEI1 Locations...

Enter the object namesz to zelect [examples]:
Inzbridgs] Check Mames

i

Advanced. .. | 0k, I Cancel |

4

Figure 11 Entering the User

7. Enterin the user name (insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.
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Permissions for Insbridge EH I

Security |

Group or user names:

ﬁ Administrators wIMAPPODT Mdministrataors) j

€7 CREATOR OWNER
€7 IERU User [wINAPPOD1 I nsbridge)
ﬁ Power Uzers [WwIMNAPPOOT\FPower Users)

lT?-:chl:u
4

I _»I_I
{ Bemove |

Permizszions for IBRU zer Allova Derm
Full Cantral O
Read O
Special Permizsions O O

For zpecial permizzions or for advanced settings, Advanced |
click Advanced. =

k. Cancel | Lpply |

Figure 12 Applying Permissions for 2003 User

9. On the Permissions screen, make sure the insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

10. Click OK.

Export Insbridge Registry Key for Backup

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server.

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
2. Right click and select Export.

3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

In the event of a catastrophic server failure, where the RM/IBFA server is non-recoverable, the IBRU
system will need to be reinstalled. When RM/IBFA is re-installed on a new server, a new registry key will
be created. This key will not match with the registry key associated with any packages that have been
created. In order to load packages to the new server, you will need to restore the previous registry key.
You may also be requested to send to your registry key to support.
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STEP 3 — ASSIGNING PERMISSIONS — TEMP FOLDER FOR MSMQ

Assigning Permissions for a Windows Temp Folder for MSMQ

1. Open Windows Explorer. Find the WINDOWS folder, most likely on your C drive.
2. Right click the Windows—->Temp folder.

@ C:\ WINDOWS", Temp

File Edit ‘iew Favorites Tools  Help | ","'
aBack > j’ | ,':J Search |t‘p Folders | [BER
Address | C:\WINDOWS) Temp = B
MName = Size | Tvpe
) orcLOEI =l Etsperfdata_SYSTEM 'Ij:e Eo::er
[ PCHEALTH = e Focer
) |C5) TestEngDated File Folder
[T PolicyBackup |
EI Prefetch ASPMNETSetup.log 1KE Text Documenk

[T provisioning dw log ; | 1KB Text Document
EI RegisteredPackages MNetFxpdate_w1.1.4322.log 7EE  Text Document

[C5) Reaiskration
El repair
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Figure 13 Assigning Permissions for the Insbridge User on Windows Temp

3. Select Properties.
4. Change to the Security tab.
5. Click Add.
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Figure 14 Temp File Properties
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On the Select Users or Groups popup, enter in the user name (insbridge) and click Check
Names. If the user name is found, it will be listed. If the name is not found, an error screen will be
displayed. Cancel out and return to the Select Users or Groups popup. Click Advanced to
search. To search the directory, click Find Now and scroll through the list until you find the user
name you need. If the user name is not listed, return to User Accounts and verify the user name
was created.

Once the name is listed, click OK.

On the Temp Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.

Click OK.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 34



Assigning Permissions for an Insbridge Folder Location

STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

1. Open Windows Explorer. Locate the INSBRIDGE folder, most often the Insbridge folder is located

at: C:\Program Files\Oracle\IGBU\Insbridge.

2. Right click the Insbridge folder.

@& My Documents H=] E3
File Edit View Favorites Tools  Help | |'f
3 Back ~ &3 - (T | - Search |ﬁ:‘: Folders | [~
Address I_r,_"j Py Documents j G0
Falders » | _Mame = | Sizel Tvpe

£ emak ;I
[C5) Common Files
(1 ComPlus Applications
) 1S
[C3) 115 Resources
|3 Installshield Installation Information
[C5) Internet Explorer
[ Microsaft MET
(£ MsBuild
[C3) MSHML 6.0
[C5) MetMeeting
) Online Services
= 3 oracle
Bl () IGEU
(S stridopy
5 Outlook Express Expand
[CT) Reference Assel Egslie
(=1 Uninstall Infarm: Open
[C5) windows Media Sy,
L) windows NT
) WwindowsUpdate Sharing and Security, ..
) wInNDows K Scan for threats...
[ wmipub
L D Drive (D2) Send To
B‘ Contral Panel Cut
g My Metwork Places G
3) Recyele Bin o
Delete ~| 4 | i

Rename

Figure 15 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties.
4. Change to the Security tab.
5. Click Add.
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Figure 16 Insbridge Folder Properties
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On the Select Users or Groups popup, enter in the user name (insbridge) and click Check
Names. If the user name is found, it will be listed. If the name is not found, an error screen will be
displayed. Cancel out and return to the Select Users or Groups popup. Click Advanced to
search. To search the directory, click Find Now and scroll through the list until you find the user
name you need. If the user name is not listed, return to User Accounts and verify the user name
was created.

Once the name is listed, click OK.

On the Insbridge Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.

Click OK. You can close out Windows Explorer.
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STEP 5 — RESTORING IBRU DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latin1_General_ CP1_CIl_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

SQL Server
- RateManager — IBRM
o Latin1_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
o SQL_Latin1_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security — IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 17 Restoring a Database to SQL Server

6. Go to Databases.
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Figure 18 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

I Restore Database - IB_CLIENT

Select "_;S Script - m Help

% General

=] 3

1 Oplions

Server
Server

Connection:
za

4 View connection properties

Degtination for restore

Select ar type the name of a new ar existing databaze for your restare aperation.

To database: [IE_CLIENT =]
To a point in time: IMDSt recent pozsible |

Saurce far restore

Specify the zource and location of backup sets to restare.

" From database: I j
' From device: ID:'\DBTempIates'\IB_ELIENT.bak |
Select the backup sets to restore:
Restore | I arne | Campotiett | Typel Server | Dratabaze | Pt
v Database Full  PLDWIGDBEWODT [B_CLIENT_TEMFLATE 1
< | ]

Ok I Canicel |

4

Figure 19 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:.

10. Select From Device.
step 2.

Click ... to browse to the location where the database files were placed in

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step

3.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

17.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 36 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 40



STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

2 Framework Administrator - Windows Internet Explorer [’L|I'E|g|
Coies v B piosahastibtaldetau s MIESE |[2]-
File Edit Wiew Favorites Tools  Help
— - . »
W I (& Framework Administratar I I f - B - = - [5reage - oo -
ORACL E msuance Insbridge Framewaork Administrator Version 04.01.00 (x86)
[x] a8
= Configuration File [C:\PROGRAM FILES\ORACLE\IGBU\INSBRIDGE\FRAMEWORK\3.5.0 \Insbridge.Xml
3 softRater The Framework Administrator Web will corfigure any Insbridge Framework Configuration file (Insbridge, xmi) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ softbata thatreside on the same Framework Server share the same file.
[ services
£ Logs Change Config File location: Browse Update
[ security
5 Softlibraries add Subscriber
@) Hep The subscriber identifr is an unigue number that you would like to represent your company. Please consult with an
pridge supporjg#resentative if you have any questions,
# No Subscribers found.
#Add Database Connection
Creste or edit database connection. This database connection can be global to the Insbridge Framewark or unique to the
Subscribar.
IClick on the name of the connection to edit.
82 Global
# ho Cannactions found,
i)
Copyright © 2000,2008, Orade andjor its affiliates. Al rights reserved.
Done

% Local intranet 0% -

Figure 20 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

To continue, you will need to exact names of the databases you restored in Step 3, IBRM_xxxx, and
IB_CLIENT databases.
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1. Click on Add Subscriber and in the next dialog.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time
you save. These entries cannot be edited. Only the description can be edited.

NOTE: Make note of the subscriber ID humber. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber. For
example, if you have an instance of IBFA on machine A, you can create a subscriber with an 1D
of 100. On machine A, if you create another subscriber, you must give that subscriber a different
ID number, say 200. If you also have an instance of IBFA on a different machine, B for example,
you should duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request
using My Oracle Support at https://support.oracle.com/.

A Subscriber -- Webpage Dialog

!

Subscriber
Flease enterfupdate your Insbridge Customer information below,

1D 8047
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

Figure 21 Enter ID
Troubleshooting Subscriber Entries

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Go to C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Sharing and Security. Select the Security tab.

3. Add the Insbridge user.
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Stay on the IBFA Main page. Select the Add Database Connection link. Three databases must be
added to IBFA:

e Subscriber: Global with Name: controller
e Subscriber: (Your Subscriber Name) with Name: security
e Subscriber: (Your Subscriber Name) with Name: RM

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

NOTE: If you have renamed the databases, please make note of the new names.

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: Global w
Mame: Contraller
Server: LocalHost Test Connection...

Server Type: | SQLServer b

Cataloq: IE_CLIENT

Catalog Type: | Other w
Query Buffer:

Tablespace:

Schema:

User: 53

Password: T

Save Cancel

Figure 22 Setting up the Global Database Connection

1. Select Global for the Subscriber. The controller database connection is a global database and
is not unique to the subscriber. This information cannot be changed once you have saved it.

2. Enter Controller for the Database Name. This cannot be changed once you have saved it.
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3. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

4. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

5. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 3.
6. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

7. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

8. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 21 if needed.

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framewaork or unique to the Subscriber.,

Subscriber: Global b

Mame: |

Server: Test Connection, ..
Server Type: | SQLServer i

Catalog:

Catalog Type: | Other w

Query Buffer:

Tablespace:

schema:

User:

Password:

Save Cancel

Figure 23 Adding a Database Connection

9. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.
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1. Next, add the security database. Select the Add Database Connection link again.
2. Select Your Subscriber. The security database is unique to the subscriber.
3. Enter Security for the Database Name. This cannot be changed once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 3.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 21 if needed.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog E]

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: Alamere Insurance v
MName: Security

Server: LocalHost Test Connection. ..
Server Type: | SQLServer w

Catalog: IB_CLIENT

Catalog Type: | Other w

Query Buffer:

Tablespace:

Schema:

User: 53

Password: Ty

Save Cancel

Figure 24 Setting up the Security Database Connection
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1. Next, add the rm database. Select the Add Database Connection link again.
2. Select Your Subscriber. The rm database is unique to the subscriber.
3. Enter rm for the Database Name. This cannot be changed once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 3.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner on page 21 if needed.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: Alamere Insurance v

Mame: RM

Server: LocalHost Test Connection. ..
Server Type: | SQLServer hd

Catalog: IBRM

Catalog Type: | RateManager | w

Query Buffer:

Tablespace:

Schema:

User: 53
Password: Ty

Save Cancel

Figure 25 Setting up the RateManager Database Connection
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NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Environments

Next, create the default rating environments for the RateManager system.
For a new installation it is recommended that you create two logical environments:

¢ RM - to handle rating and testing.

e QA —to hold the full packages that need to be consumed by the QA environment.
You can create additional environments at this time if necessary.

1. Browse to SoftRater>Explorer->Subscriber name.

NOTE: This default environment is not required if performing a SoftRater node installation. Other
environments will still need to be created to load SRPs to the IBSR databases.

= Framework Administrator. (WINAPPOO1) - Windows Internet Explorer

@ ) v B hepocahosteafetaut.asps] MIEE
Ele Edt Yew Favorites Tools Help
. . »
Y e I (& Framework Administratar (WINAPPODL) I I B- 8 d= - [ipage - () Tods +
. )
ORACL €' msurance Insbridge Framewark Administrator Version 04.01.00 (x86)
|
Settings P
=+ Insbridge e
=3 softRater
3 Engine
(=3 Explarer Configuration Add Environment
— Add, edit, or remove envighnments from your Explorer configuration.
(13 softhata
3 services
3 Loas # No environments found.
3 security
4= Softiibraries . .
Line-of -Business Management
9 rep Your rating book of businesses are identified by an id and a description. There is no limit to the number of LOB's (ine-of-
business) that your Explorer can contain.
ID - DESCRIPTION
# No Lines found.
Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server,
DESCRIPTION - SERVER - TYPE - ENVIRONMENT
# No file servers found.
< | 3 Copyright © 2000,2003, Oracle andjor its affiiates. All rights reserved.
Done % Local intranet E100%

Figure 26 Create a Rating Environment
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2. Click on Add Environment.

2 Environments -- Webpage Dialog

A SoftRater configuration can support an unlimited number of environments.

Mame: RM_Default

Type: | Dewv e

Secure: [ ]

Save Cancel

Figure 27 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU system
is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.
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Defining the Logical Environment

ORACL_E msurance Insbridge Framework Administrator

=3 Insbridge
EIEZ SoftRater

[ Engine

EIE] Ewplorer

----- Alamere Insurance

Add Environment
Add, edit, or remove environments from your Explorer configuration,

-1 SoftData NAME - DESCRIPTION

-~ Services # RM Default - Development

F-C3 Logs # QualitvControl - Quality Assurance
E-E8 Searity # SR _BM - Production

Figure 28 Obtaining Environment Information

4. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen.

/= Framework Administrator, (WINAPPOO1) - Windows Internet Explorer

G@ ~ | & etpujLocahost/BRAfdeFaut.aspx] B [2][5¢] [ive seoren |[2]]

© Fle Edt Wew Favorites Tools Help

T & | @ Framewark Administrator (WINAPPODL) [_I 3 - - [Page v (FTeds v
ORACL_E nsurance Insbridge Framework Administrator Version 04.01.00 (x86)
x|
- Insbridge
-3 sofRater
{3 Engine il

Configuration DEVELOPMENT

Environments Environment(s) you may use for development purposes, Selecting an environment below wil denote it as the default,

3 services Environment: RM_Defauit [©]
£ Logs Package Locat
A security DB Server: WINAPPOO3 !
5 Softlibraries DB ServerType: 5QLServer | a
@) tep DE Catalog: IERM_Alamere
DB CatalogType: RateManager ~|
DB Query Buffer:
DB Tablespace:
DB Schema: A
DE User: sa
DE Password: sessnsns
Engine Type: Windows ~|
Engine Location: LOCALHOST
Engine EnvDef:

Enviranment(s) you may use for quality assurance purpases. Selecting an environment below will denote it as the default.

Environment: QualityControl (@]

PackageLocation:  |C:\Insbridge|SRP

DB Server: WINAPPODZ

DB ServerType: SQLServer ~|

DE Catalog: 185R_Alamere

DE CatalogType: SoftRater ~]

DB Query Buffer:

J— |

Done ol intranet | R - -

Figure 29 Editing Environment
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5. Environment, DB Server, DB Server Type, DB Catalog, DB Catalog Type, DB User, DB Password,
Engine Type and Engine Location is required for the RateManager connection. The Package
Location, DB Query Buffer, DB Tablespace, DB Schema, and Engine EnvDef can remain blank. The
user account should be the database owner (for example, Insbridge).

For each environment, you can set up the following information:

Environment: The name of the environment. Selecting the radio button next to an
environment's name will set it up as the default environment.

Package Location: Physical location of where the packages should be stored. Click Test
Environment to validate the permissions on the directory and certify
any packages in the directory. The Framework Administrator must
have full control of the directory. RateManager environments will not
have a package location.

DB Server: The name of the server that houses the database that packages will be
loaded to. For DB2 servers, this is the DB2 Registered Alias Name.
For Oracle servers, this is the server name; either IP or DNS will work.
The Database listener port number will also need to be appended to
the server name if it is something other than the default port.

The format for this is as follows: [SERVER NAME]:[PORT NUMBER]

DB Server Type: The type of server that houses the database. Currently, RateManager
and SoftRater support:
o SQL Server
e Oracle
e Oracle XE
L] DBZ

o DB2 Mainframe

If you select an Oracle XE database server type, a message will be
displayed informing you that the schema for the environment has been
changed to match the name of the environment. The DB schema
cannot be changed.

DB Catalog: The name of the catalog in the database. For DB2 servers, this is the
System DSN Name. For Oracle servers, this is the instance.

DB Catalog Type: The type of catalog in the database. The types available are:
RateManager, SoftRater and Other. If you are using a SQL Server,
you can choose either RateManager or SoftRater. If you are using an
Oracle or DB2 database, you will need to choose Other and enter the
remaining information.

*DB Query Buffer: For certain Database Management Systems (DBMS), system batch
query optimization is required for performance and/or because of limits
on/in the system. This value will control the maximum number of batch
query operations that can be submitted to the target DBMS in any one
transaction. It is known that for certain DB2 platform versions a value
of 31 is required because of a hard software limit.

DB Tablespace: For future use.

*DB Schema: The name of the schema that defines the structure of the database.
This information may be obtained from the Oracle DBA.

If DB Server Type Oracle XE is selected, the DB Schema name will be
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the same as the Environment Name.

DB User: Username to access the database. This information may be obtained

from the DBA.

DB Password: Password to access the database. This information may be obtained

from the DBA.

Engine Type: The type of SoftRater engine that is used. The available options are:

Windows, WebSphere, WeblL ogic or JBoss.

Engine Location:

The location of the SoftRater engine. If the engine is local to the
Framework Administrator (i.e. located on the same server), leave this
field as LOCALHOST. If the engine is located on a different server,
enter the name in the box. WebSphere, WebLogic or JBoss must also
include the port that is being used.

e WebLogic: Port 7001
e WebSphere: Port 9080
e JBoss: Port 8080

Engine EnvDef: This field should remain blank, unless the engine is located on a

different server. If the Engine Location is set to LOCALHOST, leave
this field blank. If the Engine Location is not LOCALHOST, this
should match the name of the environment on the remote server.

NOTE:

* [tems marked with an asterisk only need to be entered/edited if you are using an Oracle or DB2
server.

6. After you have entered your information, scroll to the bottom of the page and click Save to save your
environments. After you have saved your settings, a new tab will be displayed, Content. This tab will
not be needed for a new installation.

Creating a RateManager Environment

It is recommended that only one RateManager environment be created.

On the Settings tab, select Environments.

This will open up the Environments subtab. The environments you previously setup will be listed.
If an environment is missing, you must return to the Configuration subtab and add it.

The Environment Name will be complete. No changes are needed.

RateManager environments will not have a Package Location. No entry will be allowed.

Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored.

The DB Server Type will be SQL Server.

The DB Catalog is the name of the RateManager database restored in SQL Server.

The DB Catalog Type is RateManager.

DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.

. Enter the DB User name and Password.
. The Engine Type is Windows.
. The Engine Location default is LOCALHOST. Most RateManger installations have a local

engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 51



13. The Engine EnvDef default is a blank field. Most RateManger installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

14. Click SAVE to save your entries.

Creating a SoftRater Environment

A SoftRater environment may be completed at installation or can be added at a later time. A SoftRater
environment can be on a Windows machine or a Java machine running an application server, such as
WebLogic. There is no limit to the number of SoftRater environments that you can have.

1. On the Settings tab, select Environments.

2. This will open up the Environments subtab. The environments you previously setup will be listed.
If an environment is missing, you must return to the Configuration subtab and add it.

3. The Environment Name will be complete. No changes are needed.

4. Enter in the file path where you want packages stored in the Package Location. Use the Test
Environment option to have the location created for you.

5. Enterin the DBServer name or IP address. This is the database server where the SoftRater
database was restored or created.

6. Select the DB Server Type that you are using.

7. The DB Catalog is the name of the SoftRater database restored in SQL Server or created in
Oracle or DB2.

8. The DB Catalog Type is SoftRater.

9. DB Query Buffer may be required. For certain Database Management Systems (DBMS), system
batch query optimization is required for performance and/or because of limits on/in the system.
This value will control the maximum number of batch query operations that can be submitted to
the target DBMS in any one transaction. It is known that for certain DB2 platform versions a value
of 31 is required because of a hard software limit

10. DB Tablespace is not required for a SoftRater environment.

11. The DB Schema is the name of the schema that defines the structure of the database. This
information may be obtained from the DBA.

12. Enter the DB User name and Password.

13. Select the Engine Type.

14. The Engine Location is the location of where you installed the SoftRater engine. You can use
the machine name or IP address. For WebSphere, WebLogic or JBoss, you must also include the
port. For example, a WebLogic server may have “WBServerName:7001” as the entry.

15. The Engine EnvDef is the machine name if the engine is located on a different server. You can
use the machine name or IP address.

16. Click SAVE to save your entries.

Creating a SoftRater Oracle XE Environment

A SoftRater environment may be completed at installation or can be added at a later time. An Oracle XE
environment must be on the same server as IBFA. Oracle XE cannot be run through an application
server, such as WebLogic. All supported engines (WebSphere, JBoss, WebLogic, Windows) in the IBFA
Engine dropdown can rate against an Oracle XE database.

When creating and utilizing an Oracle XE environment, naming must be consistent. The names used in
IBFA must be used in SoftRater Native. Oracle XE is case sensitive and has a 4GB limit.

Prior to setting up an Oracle XE environment, please run the oracle client on the machine where IBFA
and Oracle XE are installed. The oracle client is included the download file from E-Delivery.
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On the Settings tab, select Environments.

This will open up the Environments subtab. The environments you previously setup will be listed.
If an environment is missing, you must return to the Configuration subtab and add it.

The Environment Name will be complete. No changes are needed.

Enter in the file path where you want packages stored in the Package Location. The package
location must be on the server where IBFA is located. Use the Test Environment option to have
the location created for you. If you have not loaded a package to the XE environment, you may
receive an error message instructing you to run the DDLs. DDLs will be run against an XE
environment the first time you load a package. You do not need to run the DDLs prior to loading
any packages.

Oracle XE must be on the same server as IBFA. The DBServer is LOCALHOST.

The DB Server Type will be Oracle XE. When you select an Oracle XE database server, an
information screen will be displayed. The schema will be changed to match the name of the
environment.

Click OK.

Message from webpage E]

L] "_-. The schema for the environment has been changed to match the name of the environment, (QOracle $E)
L

Figure 30 Oracle XE Message

10.
11.

12.
13.
14.

15.

16.

The DB Catalog is the database name. If you are unsure of the name, you can view this
information on the Oracle XE database Home Page. Home->Administration>About Database,
select settings and click GO. The name will be listed in the database information window.

The DB Catalog Type is SoftRater.

DB Query Buffer and DB Tablespace are not required for an Oracle XE environment.

The DB Schema was set when you selected the DB Server Type. This information can only be
changed if a different DB Server Type is selected.

Enter the DB User name and Password.

The Engine Type is Windows.

The Engine Location default is LOCALHOST. Oracle XE must be on the same machine as
IBFA. If the IBFA engine location is not on the local machine, enter the server name or IP address
where the IBFA engine is located. Do not change LOCALHOST to the name or IP address of the
local machine.

The Engine EnvDef default is a blank field. Oracle XE must be on the same machine as IBFA. If
the IBFA engine location is not on the local machine, enter the server name or IP address where
the IBFA engine is located.

Click SAVE to save your entries.
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STEP 7 — VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.
1. Click Start->Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

nponent Services

File  Action  Wiew | window  Help

€~ B X2R 2B 0%

C_l Console Root
E@ Component Services

=13 Computers .MET Utiities  COM+

Eg My Computer

COMA+ Qi COMA+ Utilities 115
Explarer Dead Let.., Cuk-0F-Pro...

COM+ Explorer E
COM+ Qi Dead Letker Queus Listener Insbridge Insbridge Insbridge System
COM+ Utilities Com+ Ad... Com+ ... Com+ ... Application

13 Cub-Of-Process Pooled Applications
nsbridge Com+ Administrator 3.5
nshridge Carm+ SoftRater Engine

& Insbridge Com+ SoftRater Library
-8 Systern Application

-] DM Config

-1 Distributed Transackion Coordinator
[]---D Running Processes

[]--@ Active Direckory Users and Computers

[]--% Ewent Viewer (Local)

Services (Local)

Figure 31 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
e Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The installation

will automatically apply the Insbridge user name and password that you created earlier to the necessary
libraries. If you change the password, you will have to change the password in all three of the Insbridge
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Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.

Older instances of Insbridge may also have a fourth Com+ library.

For Windows Server 2008

1. Click Start=>Administrative Tools=>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer>COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.
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STEP 8 — ALLOWING FOR WCF ACTIVATION

FOR WINDOWS SERVER 2008 ONLY. Windows Server 2003 can skip this step.

WCF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools->Server Manager.
2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.
3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard E3
= ]

=

%}' Select Features

(@1

Select one or more Features to install on this server,

Confirmation Features: Descripkion:

Frogress windows Commurnication Foundation
J = \MET Framework 3.0 Features {Installed) = [WCF) Activation Uses Windows
Resulks MET Framework 3.0 (Installed) Process Activation Service ko invoke

applications remokely owver the
netwaork using protocols such as

|: BitLacker Drive Encrytin HTTP, Message Queuing, TCP, and

|: BITS Server Extensions named pipes. Consequenthy,
applications can start and stop

|: Zonnection Manager Administration Kik dwnamically in respanse ta incaming
[ Desktop Experience waork items, resulking in application
|: Group Policy Management hiasking that is more robust,

] 1nternet Prinking Client manageable, and efficient.

|: Internet Storage Mame Server
[ LPR Port Monitor
[E Message Queding (Installed)
] mulkipath 1o
[ metwork Load Balancing
[ peer Mame Resolution Protocol
[ cuality Windows Audio Yideo Experience
|: Remaote Assistance
[ remote Differential Compression
Remoke Server Administration Tools {Installed)
[] removable Storage Manager LI

More about Features

= Preyious | ext = | Install | Zancel I

Figure 32 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 9 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1.

Unzip the OBI_PUBLISHER

% OBI Publisher Setup BB
0B1 Publizher —
Release MNates, (*‘7

Install l [ Cancel

Figure 33 Installing OBI Publisher

2.

3.
4.

Click Install. A progress screen will be displayed.

When complete, click Close.

In order for OBI Publisher to be available to users, you must start the Insbridge Message Service.
The Insbridge Message Service can be started from IBFA or from Services in Windows 2003 or the
Server Manager in Windows 2008.

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.
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Starting Insbridge Services

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to
execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,
View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS
Figure 34 Insbridge Services Screen
1. In IBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click |23t | After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start | After a few seconds, the buttons will refresh to indicate
that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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Chapter 4

SOFTRATER NODE INSTALLATION

Before installing, please verify that the requirements are in
place.

The installation must be performed in the following order:
1. Install the IBRU application without RateManager.

2. Registry Access.
a. Assigning Insbridge Access.
b. Exporting Key for safe keeping.

3. Assigning permissions to the Insbridge User for the
Windows Temp Folder. This is necessary for MSMQ

4. Assigning permissions to the Insbridge User for the
Insbridge Folder

5. Creation of the QA_SR databases is next.
6. Return to IBFA and Configure:

a. Create your subscriber.

b. Create your logical environment.

c. Create your Virtual File Server connection.
7. Verifying Component Services.
8. Exporting/Importing the Registry Key
9. Allowing for WCF Activation. FOR WIN 2008 ONLY.
10. Install OBI Publisher.

For a Windows 2008 Server installation, you must run
as Administrator.
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SOFTRATER NODE

This type of installation is also called a SoftRater node installation. A SoftRater node is an IBFA instance
on a machine that allows for packages to be copied and loaded from environment to environment. A
SoftRater node installation is done on a Windows machine and can have either a SQL Server database
or an Oracle or DB2 database.

This type of install is like a Full RateManager Installation with the RateManager option set to not install.
Also, a Virtual File Server will be set up to allow this machine to communicate with the RateManager
machine.

This installation will be the same for the Production environment with a Virtual File Server set up to allow
it to communicate with the QA machine.

SoftRater Nodes can be added any time after RateManager has been installed.
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

i'g!;!' Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B |

4 Oracle Insurance Insbridge Rating and Underwriting

[tiz strongly recommended that you exit all Windows programs befare running this setup program.

Click Cancel to quit the zetup pragram, then cloze any programs pou bave running. Click Mest to
continue the installation.

WARMIMG: Thiz program iz protected by coperight law and international treaties.

Ilnauthorized reproduction or distnbution of thiz program, or any portion of it, may result in severe civil
and criminal penalties, and will be prozecuted to the masimunm extent pozsible under law.

ORACLE

INSURANCE

Cancel |

Figure 35 Installing Insbridge

3. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The “Wize Installation “izard will inztall the files far Oracle Insurance - Inzbridge Bating
and Lndenwriting in the following folder.

To ingtall into a different folder, click the Browse button, and zelect another folder.
'ou can choose not ba install Oracle Insurance - Insbridge B ating and Undenwriting by
clicking Cancel to exit the ‘Wize Installation *izard.

Drestination Folder
{E:'&F‘HDGH.&M FILESSORACLENGEUMMSERIDGEY

Wize Inztallation YWizard [R]

Figure 36 Entering the Destination Folder for Insbridge

4. Choose the location where the Insbridge installation will be located. This will be the location for all
future installations for Insbridge applications. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Logon Information DRACLE‘

The following logon information is uzed by Inshbridge. INSURANCE

Specify a uzer account ba be uzed by the application, either far running a service ar for
logging onto other serverz. Uze the Browse button to chooze wzers from pour nebwaorl.
Faor damainz, user names must be in the format of DOMAINW seM ame.

User M ame: |Insl:uriu:|ge Browsze. .. |

Pazzwiord: Ixxxxxx,mﬁ

Create Mew Lzer. . |

Wize Inztallation YWizard [R]

< Back | Hest » I Cancel

Figure 37 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 21.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Select Features C}RACLE‘

Pleaze select which features you would like to install.
! INSURANCE

Feature Description:
R atebd ananer alliws husiness uzers o create,

&= vI Inzbridge A ating & Undenariting
| |

C = Wil be installed on local hard drive. rates and rules

P = v| ting engine in an

=18 Entire feature will be installed on local hard drive,

f=)  Feature will be installed when reguired. ti the local hard

Entire feature will be unawvailable,

v pour hard drive.

Current location:

C:“PROGRAM FILESYORACLEMGELUNMSERIDGE
Wize Inztallation YWizard [R]

Dizk Cost Beset < Back | Hest » I Cancel

Figure 38 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that
you will be allowed to not install. Check Entire feature will be unavailable. Click Next to continue.

Options are:

o Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive. This includes
IBFA.
- You will not be able to opt out of this selection.

o RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed. You do not need to install RateManager.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.
- This option does not install the OBI Publisher. Only the templates required by the IBRU
application will be installed on local hard drive.
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i'él Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= E3 |

Ready to Install the Application ORACLE

Click Mext ta begin installation. INSURANCE

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

Wize Inztallation \wizard [R]

Cancel |

¢ Back

Figure 39 Ready to Install

8. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check
the options you want to install.

i,él Oracle Insurance - Insbridge Rating and Underwriting Setup M= BB |
Updating System ORACLE
The features you selected are currently being installed. INSURANCE

Yalidating inztall...

YWize Inztallation ‘wizard [R]

Figure 40 Installation Progress
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Readme Information DRACLE‘

|nzbridge has been successfully installed. INSURANCE

Microsoft Windows 2003/2008 Server o
A full installation of Microsoft Server 20032008 is required. The following
configuration assumes that the administrator of the senver to be generally
familiar with managing a Windows server. i

Internet Information Services (lI5)

The InsBridge Rating and Underwriting System is a web based application and
requires IS to be installed before installation to facilitate the default web virtual
directaries creations.

The subcomponents of IS needed by IBRL:

. Commaon Files
. Documentation
. Internet Information Serices Snap-In |

YWize [nstallation ‘wizard®

Figure 41 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — CONFIGURING REGISTRY ACCESS

WARNING: If you use Registry Editor incorrectly, you may cause serious problems to the operating
system. These problems may require you to reinstall your operating system. Insbridge cannot
guarantee that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Selecting Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

& Registry Editor

File Edit Wiew Favorites Help

= My Computer Mame Type | Data
-] HKEY_CLASSES_ROOT [ab](Default) REG_SZ {alue not set)
{2 HKEY_CURRENT_USER
B0 HKEY_LOCAL_MACHINE
- HARDWARE
- 5aM
(] SECURITY
- SOFTWARE
- Co7rsy
-] Classes
- Clients
- Gemplus
[ GHU
£
[

74
7] Installs  Expand
(] lameme  Hew L
H-(] Mcafee  Eind...

7-{_7] Microso

E
E

Delet
ECD Mozl
E
E
E

R
7-{_] MozilaF AN

1] Networ Expart
(3 oDBC Permissions. ..
ool
F-] Policies S0Py Key Name |
{1 Program Groups |
-{_] Schiumberger
(] Secure

-1 SYSTEM

{1 HKEY_USERS

-0 HKEY_CURRENT_CONFIG

|My ComputeriHKEY _LOCAL_MACHINE\SOFTWARE\Insbridge 4

Figure 42 Configure Registry Access Windows Server
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4. Right click and select Permissions.
5. Click Add.
6. On the Select Users or Groups popup, select the Object Types and Locations.

select Users or Groups

Select thiz object type:

ILlsers, Groups, or Built-in zecurity principals Object Types...

From thiz location:
IWIN:‘-&F‘F‘Dm Locations...

Enter the object names to select [examples]:
Inzbridags] Check Names

iG

Advanced... | ] 4 I Cancel |

4

Figure 43 Entering the User

7. Enterin the user name (insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.
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Insbridge Properties |

Generall Sharing Security |Wel:| Sharingl Eustu:umizel

Group ar user names:

E Administrators PwWIMNAPPODT Administrators)
€7 CREATOR OWNER

L “IBRU User [WINAPPOO1 \Inshridge)
ﬁ Power Usgers [WIMNAPPOOT\Power Users]

€7 SvSTEM -
1| | »

Add... | Bemove |
Permizszions for IBRU Lzer Allova Derm
Full Cantral =
b odifye

Read & Execute
Lizt Folder Contents
Read

hd
For zpecial permizzions or for advanced settings, Advanced |
click Advanced. =

k. I Cancel | Spply |

Figure 44 Applying Permissions for 2003 User

IEEEREE
1jO0000o0

9. On the Permissions screen, make sure the insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

10. Click OK. You can close out the Registry Editor.

Export Insbridge Registry Key for Backup

The Insbridge registry key located in HKEY _LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server. In the event of a catastrophic server
failure and the IBRU system needs to be reinstalled, you will need, and/or be requested to send to
Insbridge, your registry key.

Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE-Insbridge.

Right click and select Export.

Select a storage location for the file and Save.

For a SoftRater Node ONLY install, DO NOT close out of Registry Editor. After you create an
Insbridge subscriber, you will need to export/import the registry key.

PN~
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STEP 3 — ASSIGNING PERMISSIONS — TEMP FOLDER FOR MSMQ

Assigning Permissions for a Windows Temp Folder for MSMQ

1. Open Windows Explorer. Find the WINDOWS folder, most likely on your C drive.

2. Right click the Windows—->Temp folder.

@ C:\ WINDOWS", Temp

File Edit ‘iew Favorites Tools  Help

aBack > j’ | ,':J Search |t‘p Folders | [BER

Address | C:\WINDOWS) Temp

H8e

Falders

b

£ oRCL

L5 Palicy

I TaP
) Tasks

L5 bwaail

= O e

QBT

[T PCHEALTH

Backup

[0 Prefekch
[C5) provisioning
|1 RegisteredPackages
[C5) Reaiskration

El repair
[T Resources
[C5) security
[ FervicePackFiles
[C5) SoftwareDistribution
|50 srchasst

[C5) system

[ system3z

Expand

[T weE
5 Web
[ Wing

Explore
Qpen
Search...

IC5) wmpub
L D Drive (D

Sharing and Security..,

[ control Pane

§J Scan for threats...

g My Metwaork, Flac
_-EJ Recycle Bin

Send To

Cut
Copy

MName = Size | Tvpe

) hsperfdata_sySTEM File Folder
IiLogs File Folder

|C5) TestEngDated File Folder
ASPMETSetup.log 1KE Text Documenk
dw.log 1KE Text Document

MetFyxpdate_w1.1.4322.lag

al

7KE  Text Document

Delete

Rename

Figure 45 Windows Explorer WINNT Properties

3. Select Properties.

4. Change to the Security tab.

5. Click Add.
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Figure 46 Windows Temp File Properties
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6. On the Select Users or Groups popup, select the Object Types and Locations.

7. Enterin the user name (insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.

9. On the Temp Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.

10. Click OK.
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STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location

1.

2. Right click the Insbridge folder.

Open Windows Explorer. Locate the INSBRIDGE folder, most often the Insbridge folder is located
at: C:\Program Files\Oracle\IGBU\Insbridge.

@& My Documents H=] E3
File Edit View Favorites Tools  Help | |'f
3 Back ~ &3 - (T | - Search |ﬁ:‘: Folders | [~
Address I_r,_"j Py Documents j G0
Falders » | _Mame = | Sizel Tvpe

£ emak ;I
[C5) Common Files
(1 ComPlus Applications
) 1S
[C3) 115 Resources
|3 Installshield Installation Information
[C5) Internet Explorer
[ Microsaft MET
(£ MsBuild
[C3) MSHML 6.0
[C5) MetMeeting
) Online Services
= 3 oracle
Bl () IGEU
(S stridopy
5 Outlook Express Expand
[CT) Reference Assel Egslie
(=1 Uninstall Infarm: Open
[C5) windows Media Sy,
L) windows NT
) WwindowsUpdate Sharing and Security, ..
) wInNDows K Scan for threats...
[ wmipub
L D Drive (D2) Send To
B‘ Contral Panel Cut
g My Metwork Places G
3) Recyele Bin o
Delete ~| 4 | i

Rename

Figure 47 Insbridge Folder
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Select Properties.

Change to the Security tab.
Click Add.

On the Select Users or Groups popup, select the Object Types and Locations.

Enter in the user name (insbridge) and click Check Names. If the user name is found, it will be

listed. If the name is not found, an error screen will be displayed. Cancel out and return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find
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Now and scroll through the list until you find the user name you need. If the user name is not
listed, return to User Accounts and verify the user name was created.

8. Once the name is listed, click OK.
9. On the Insbridge Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.

Insbridge Properties H |

Generall Sharing  Security |Wel:| Sharingl Eustn:nmizel

Group or user names:

E Adrmiriztrators [WINAPPODT \Administrators]
€7 CREATOR OWNER

| 5§ IBRL User ['WINAPPOI Ynsbridge)
ﬁ Power Uzers [WwWINAPPOD SPower Users)

€7 SvSTEM -
1| | v

Add... | Bemowve |
Permizzions for IBRU Lzer Al Deny
Full Cantral =
b cucdify

Read % Execute
Ligt Folder Contents
Fead

[
For special permizzions or for advanced settings, Advanced |
click Advanced. =

2k, I Cancel | Spply |

Figure 48 Setting Permission for Insbridge Folder
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10. Click OK. You can close out Windows Explorer.
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STEP 5 — RESTORING A SOFTRATER DATABASE IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latin1_General_ CP1_CIl_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

SQL Server
- SoftRater — IBSR
o Latin1_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
o SQL_Latin1_General_CP1_CI_AS
» DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Usp IBSR v03.13.0.sql

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
SoftRater — IBSR file is only non-case sensitive.

3. Copy the file to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename the file. It is not required but it is strongly suggested that the database file name be
changed from TEMPLATE to something that defines the database more accurately. At a
minimum, it is recommended that you remove “ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 49 Restoring a Database to SQL Server

6. Go to Databases.

icrosoft SOL Server Management Studio - [Object Explorer Details]

L_‘ggi File Edit Wew Tools Window Community Help -F X
Quewoey || BBE/IE SIS E S BB,
2 - 7 X

EaT
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w Mew Database...

[ Security SOUTHERM\Databases 131 Item(s)
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Figure 50 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

I Restore Database - IB_CLIENT

Select "_;S Script - m Help

% General

=] 3

1 Oplions

Server
Server

Connection:
za

4 View connection properties

Degtination for restore

Select ar type the name of a new ar existing databaze for your restare aperation.

To database: [IE_CLIENT =]
To a point in time: IMDSt recent pozsible |

Saurce far restore

Specify the zource and location of backup sets to restare.

" From database: I j
' From device: ID:'\DBTempIates'\IB_ELIENT.bak |
Select the backup sets to restore:
Restore | I arne | Campotiett | Typel Server | Dratabaze | Pt
v Database Full  PLDWIGDBEWODT [B_CLIENT_TEMFLATE 1
< | ]

Ok I Canicel |

4

Figure 51 Restoring a Database

9. Enter your IBSR database name in To Database:.

10. Select From Device.
step 2.

Click ... to browse to the location where the database files were placed in

11. Select your database IBSR_ xxxx.BAK, where xxxx equals the renamed file from step 3.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.
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14.

15.

16.

Click OK.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Once the database is restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

For ease of administration, the database user should have db_owner permissions on the
IBSR_xxxx database.
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STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

2 Framework Administrator - Windows Internet Explorer [’L|I'E|g|
Coies v B piosahastibtaldetau s MIESE |[2]-
File Edit Wiew Favorites Tools  Help
— - . »
W I (& Framework Administratar I I f - B - = - [5reage - oo -
ORACL E msuance Insbridge Framewaork Administrator Version 04.01.00 (x86)
[x] a8
= Configuration File [C:\PROGRAM FILES\ORACLE\IGBU\INSBRIDGE\FRAMEWORK\3.5.0 \Insbridge.Xml
3 softRater The Framework Administrator Web will corfigure any Insbridge Framework Configuration file (Insbridge, xmi) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ softbata thatreside on the same Framework Server share the same file.
[ services
£ Logs Change Config File location: Browse Update
[ security
5 Softlibraries add Subscriber
@) Hep The subscriber identifr is an unigue number that you would like to represent your company. Please consult with an
pridge supporjg#resentative if you have any questions,
# No Subscribers found.
#Add Database Connection
Creste or edit database connection. This database connection can be global to the Insbridge Framewark or unique to the
Subscribar.
IClick on the name of the connection to edit.
82 Global
# ho Cannactions found,
i)
Copyright © 2000,2008, Orade andjor its affiliates. Al rights reserved.
Done

% Local intranet 0% -

Figure 52 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

4. Click on Add Subscriber and in the next dialog.
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The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

NOTE: Make note of the subscriber ID humber. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber. For example, if you
have an instance of IBFA on machine A, you can create a subscriber with an ID of 100. On machine A, if
you create another subscriber, you must give that subscriber a different ID number, say 200. If you also
have an instance of IBFA on a different machine, B for example, you should duplicate the same
subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using My
Oracle Support at https://support.oracle.com/.

A Subscriber -- Webpage Dialog @

Subscriber
Please enterfupdate your Insbridge Customer information below.

ID: 8047
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

Figure 53 Enter ID
Troubleshooting Subscriber Entries

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Go to C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Security.

3. Add the Insbridge user.

NOTE: If you have renamed the databases, please make note of the new names.
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Creating Environments

Next, create the default rating environments for the SoftRater node.
It is recommended that you create one logical environment:

e SR - to identify the location of the local SRPs and the QA IBSR DB.

1. Browse to SoftRater>Explorer>Subscriber name.

= Framework Administrator (WINAPPOO1) - Windows Internet Explorer

.y = | &) hitpifLocalhostTBFa/default. asps] | ||| x| [Live search P
© d|Ed

© Ble Edt Wew Favorites Iools Help

T & | @ Framework Administrator (WINAPPODL) [7| - i - [rpage - (hTecs v

| ORACLE " msurance Insbridge Framework Administrator Version 04.01.00 (x86)

=3 Insbridge
E-C3 softRater
[ Engine
= Explorer Configuration Add Envi
e — Add, edit, or remove envirdfiments from your Explorer configuration.
(3 softpata NAME - DESCRIPTION
73 Services .
3 Loas # No emerenments found.
3 security
4= Softiibraries - ~
Line-of-Business Management
) e Your rating book of businesses are identified by an id and a description. There is no limit to the number of LOB's (ine-of-
business) that your Explorer can contain.
D - DESCRIPTION
# No Lines found.
Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server,
DESCRIPTION - SERVER - TYPE - ENVIRONMENT
# No file servers found.
< m; | >
Done S R [ | Q Local intranet | Bi0% v

Figure 54 Create a Rating Environment

2. Click on Add Environment.
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2 Environments -- Webpage Dialog

A SoftRater configuration can support an unlimited number of environments,

MName: SR_WL

Type: Prod b

Secure: |

Save Cancel

Figure 55 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU system
is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACL_E nsurance Insbridge Framework Administrator

x|
-3 Insbridge Settings

I_——_||_:I SoftRater

|_j Engine

E||_:I Explorer Add Environment

BT Add, edit, or remove environments from your Explorer configuration.

- SoftData
-l Services
F-d Logs # SR WL - Production
F-[J Security

Figure 56 Obtaining Environment Information
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4. Select the Environments link under the Config header on the left hand side to enter the configuration
information for the newly created logical environment. You will be placed on the Environments
screen.

= Framework Administrator. (WINAPPOO1) - Windows Internet Explorer

@\ )~ [ itpppocalhoseteFadefut. asp] ¥[2][x] | 2]
Fle Edt Yiew Favortes Toos  Help
— . »
* I@FramewurkAdm\mstratw(WINAPPUUl) I I 2-8 o - |k page - () Tooks -

DRACI_G. Insurance Insbridge Framework Administrator

Version 04.01.00 (x86)

x
=0 Tnsbridge SIS
3 SoftRater
[3 Engine S
253 Evplorer Configuration
o — Environments Environment(s) you may use for production purposes. Selecting an environment below will denote it as the default.
[ SoftDats
3 Services Environment: SR_WIL O
3 Logs PackageLocation:  |C:\Insbridge|SRP Test Environment...
[ security DB Server: LOCALHOST
& Softibraries 08 ServerType:
©) Help DB Catalog: ibsr_uil
DE CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema: schema10
DB User: sa
DB Password: cesesnne
Engne Type:
Engine Location: LOCALHOST
Engine EnvDefi Discover
b
£ | & Copyright © 2000,2008, Oracle and/or its affilates. Allrights reserved.
Done % Local intranet F100% -

Figure 57 Editing Environment

5. Environment, DB Server, DB Server Type, DB Catalog, DB Catalog Type, DB User, DB Password,
Engine Type and Engine Location is required for the RateManager connection. The Package
Location, DB Query Buffer, DB Tablespace, DB Schema, and Engine EnvDef can remain blank. The
user account should be the database owner (for example, Insbridge).

For each environment, you can set up the following information:

Fields:

Fields must be complete for each environment.

The name of the environment. Selecting the radio button next to an
environment's name will set it up as the default environment.

Environment:

Physical location of where the packages should be stored. Click Test
Environment to validate the permissions on the directory and certify
any packages in the directory. The Framework Administrator must

Package Location:
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have full control of the directory. RateManager environments will not
have a package location.

DB Server: The name of the server that houses the database that packages will be
loaded to. For DB2 servers, this is the DB2 Registered Alias Name.
For Oracle servers, this is the server name; either IP or DNS will work.
The Database listener port number will also need to be appended to
the server name if it is something other than the default port.

The format for this is: [SERVER NAME]:[PORT NUMBER]

DB Server Type: The type of server that houses the database. Currently, RateManager
and SoftRater support:

e SQL Server

e Oracle
e Oracle XE
e« DB2

o DB2 Mainframe

If you select an Oracle XE database server type, a message will be
displayed informing you that the schema for the environment has been
changed to match the name of the environment. The DB schema
cannot be changed.

DB Catalog: The name of the catalog in the database. For DB2 servers, this is the
System DSN Name. For Oracle servers, this is the instance.

DB Catalog Type: The type of catalog in the database. The types available are:
RateManager, SoftRater and Other. If you are using a SQL Server,
you can choose either RateManager or SoftRater. If you are using an
Oracle or DB2 database, you will need to choose Other and enter the
remaining information.

*DB Query Buffer: For certain Database Management Systems (DBMS), system batch
query optimization is required for performance and/or because of limits
on/in the system. This value will control the maximum number of batch
query operations that can be submitted to the target DBMS in any one
transaction. It is known that for certain DB2 platform versions a value
of 31 is required because of a hard software limit.

DB Tablespace: For future use.

*DB Schema: The name of the schema that defines the structure of the database.
This information may be obtained from the DBA.

If DB Server Type Oracle XE is selected, the DB Schema name will be
the same as the Environment Name.

DB User: Username to access the database. This information may be obtained
from the DBA.

DB Password: Password to access the database. This information may be obtained
from the DBA.

Engine Type: The type of SoftRater engine that is used. The available options are:
Windows, WebSphere, WebLogic or JBoss.

The location of the SoftRater engine. If the engine is local to the
Framework Administrator (i.e. located on the same server), leave this
field as LOCALHOST. If the engine is located on a different server,
enter the name in the box. WebSphere, WebLogic or JBoss must also

Engine Location:
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include the port that is being used.

e WebLogic: Port 7001
e WebSphere: Port 9080
e JBoss: Port 8080

The format for this is: [SERVER NAME]:[PORT NUMBER]

Engine EnvDef: This field should remain blank, unless the engine is located on a

different server. If the Engine Location is set to LOCALHOST, leave
this field blank. If the Engine Location is not LOCALHOST, this
should match the name of the environment on the remote server.

NOTE:

* [tems marked with an asterisk only need to be entered/edited if you are using an Oracle or DB2
server.

After you have entered your information, scroll to the bottom of the page and click Save to save your
environments.

Creating a SoftRater Environment

A SoftRater environment may be completed at installation or can be added at a later time. A SoftRater
environment can be on a Windows machine or a Java machine running an application server, such as
WebLogic. There is no limit to the number of SoftRater environments that you can have.

1.
2.

3.

No

© ®

10.
11.

12.
13.
14.
15.

16.

On the Settings tab, select Environments.

This will open up the Environments subtab. The environments you previously setup will be listed.
If an environment is missing, you must return to the Configuration subtab and add it.

The Environment Name will be complete. No changes are needed.

Enter in the file path where you want packages stored in the Package Location. Use the Test
Environment option to have the location created for you.

Enter in the DBServer name or IP address. This is the database server where the SoftRater
database was restored or created.

Select the DB Server Type that you are using.

The DB Catalog is the name of the SoftRater database restored in SQL Server or created in
Oracle or DB2.

The DB Catalog Type is SoftRater.

DB Query Buffer may be required. For certain Database Management Systems (DBMS), system
batch query optimization is required for performance and/or because of limits on/in the system.
This value will control the maximum number of batch query operations that can be submitted to
the target DBMS in any one transaction. It is known that for certain DB2 platform versions a value
of 31 is required because of a hard software limit

DB Tablespace is not required for a SoftRater environment.

The DB Schema is the name of the schema that defines the structure of the database. This
information may be obtained from the DBA.

Enter the DB User name and Password.

Select the Engine Type.

The Engine Location is the location of where you installed the SoftRater engine. You can use
the machine name or IP address. For WebSphere, WebLogic or JBoss, you must also include the
port. For example, a WebLogic server may have “WBServerName:7001” as the entry.

The Engine EnvDef is the machine name if the engine is located on a different server. You can
use the machine name or IP address.

Click SAVE to save your entries.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 84



Adding a Virtual File Server

Virtual file server management allows you to set up a link to servers that are in different locations where
packages can be downloaded. In a typical QA environment, you will set up a Virtual File Server to point
back to the QA logical environment that you created in your RateManager Development environment.

This step is necessary if you want to copy and load packages from environment to environment, however,
if you do not have the information ready. You can do this at a later time.

1. From the Configuration Page, click the Virtual File Server Management link.

¥irtual File Seryer Manangement

nad SoftRater packages from different locations, These locations require a domain
name of an ip-address of the particular server,

DESCRIPTION - SERYER - TYPE - ENVIRONMENT

# No file servers found,
Figure 58 Virtual File Server Management Screen

2. This will open the Virtual File Server Management window.

A Virtual File Server -- Web Page Dialog

¥irtual File Server Management
Remoke SEP Server Management

#dd

# No file servers found.

Delete Selected Server(s) _ Edit Selected Server

Save Cancel

Figure 59 Virtual File Server Management Window

3. Enter the name of the server and a description. Take care when entering the server name. This
field cannot be edited. If you have made a mistake, you must delete and re-enter.
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4. Click| #dd |to add the server to the list. Enter in as many servers as you need.

5. When you are finished, click Save to save your work and return to the previous screen.
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STEP 7 — UPDATING THE COMPONENT SERVICES

Next, you will need to update the component services.
1. Click Start->Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

nponent Services

File  Action  Wiew | window  Help

€~ B X2R 2B 0%

C_l Console Root
E@ Component Services

=13 Computers .MET Utiities  COM+

Eg My Computer

COMA+ Qi COMA+ Utilities 115
Explarer Dead Let.., Cuk-0F-Pro...

COM+ Explorer E
COM+ Qi Dead Letker Queus Listener Insbridge Insbridge Insbridge System
COM+ Utilities Com+ Ad... Com+ ... Com+ ... Application

13 Cub-Of-Process Pooled Applications
nsbridge Com+ Administrator 3.5
nshridge Carm+ SoftRater Engine

& Insbridge Com+ SoftRater Library
-8 Systern Application

-] DM Config

-1 Distributed Transackion Coordinator
[]---D Running Processes

[]--@ Active Direckory Users and Computers

[]--% Ewent Viewer (Local)

Services (Local)

Figure 60 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
e Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The installation

will automatically apply the Insbridge user name and password that you created earlier to the necessary
libraries. If you change the password, you will have to change the password in all three of the Insbridge
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Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.

For Windows Server 2008

1. Click Start->Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer>COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

STEP 8 - EXPORT AND IMPORT SUBSCRIBER REGISTRY KEY FOR
SOFTRATER NODE INSTALLATION

The Insbridge registry key located in HKEY _LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported using regedt32 to a text file and stored in a safe location off the server and/or sent to Insbridge
in the event of a catastrophic server failure and the IBRU system needs to be reinstalled.

1. On the server where RateManager is installed, open regedt32, then navigate to the
HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge-> Subscribers>SUBSCRIBER_NAME
where SUBSCRIBER_NAME equals the name as entered on page Error! Bookmark not
defined..

2. Select the Registry menu option and select export.
3. Enter the key file name and save this to the desktop.
4. Copy this file to the SoftRater Node on the receiving IBFA.

5. Double-click this file. You will be asked if you wish to continue to import this data into the registry.
Select Yes.

6. If the import was successful, then you will receive a report that it was successfully installed. If the
import fails, please correct the error and try again.

Now the encryption on the RateManager server where the SRPs are created and the SoftRater Node
where the SRPs are loaded match.
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STEP 9 — ALLOWING FOR WCF ACTIVATION

FOR WINDOWS SERVER 2008 ONLY. Windows Server 2003 can skip this step.

WCF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools->Server Manager.
2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.
3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard E3
= ]

=

%}' Select Features

(@1

Select one or more Features to install on this server,

Confirmation Features: Descripkion:

Frogress windows Commurnication Foundation
J = \MET Framework 3.0 Features {Installed) = [WCF) Activation Uses Windows
Resulks MET Framework 3.0 (Installed) Process Activation Service ko invoke

applications remokely owver the
netwaork using protocols such as

|: BitLacker Drive Encrytin HTTP, Message Queuing, TCP, and

|: BITS Server Extensions named pipes. Consequenthy,
applications can start and stop

|: Zonnection Manager Administration Kik dwnamically in respanse ta incaming
[ Desktop Experience waork items, resulking in application
|: Group Policy Management hiasking that is more robust,

] 1nternet Prinking Client manageable, and efficient.

|: Internet Storage Mame Server
[ LPR Port Monitor
[E Message Queding (Installed)
] mulkipath 1o
[ metwork Load Balancing
[ peer Mame Resolution Protocol
[ cuality Windows Audio Yideo Experience
|: Remaote Assistance
[ remote Differential Compression
Remoke Server Administration Tools {Installed)
[] removable Storage Manager LI

More about Features

= Preyious | ext = | Install | Zancel I

Figure 61 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 10 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in IBFA, you do not need to
install this program.

1. Unzip the OBI_PUBLISHER

% OBI Publisher Setup BB

OBl Publigher st
Relsase Motes, (*7

his Cracle BI Publisher {Cracle Insurance - Insbridge Install) will update the current
release to 10,1,3.4.0

Install l [ Cancel

Figure 62 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.
3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Services in Windows
2003 or the Server Manager in Windows 2008.

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.
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Starting Insbridge Services

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task
Manager is a task queue that lists the tasks that are scheduled to be performed as well as the last
time the task was run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to
execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,
View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS
Figure 63 Insbridge Services Screen
1. In IBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click |23t | After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start | After a few seconds, the buttons will refresh to indicate
that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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Chapter 5
INCORPORATING AN ORACLE DB

The Windows environment utilizing an Oracle database example will displayed by machine and contains
3 application servers and 2 database servers. There are still three environments; development, QA and

Production. The Oracle database server will contain two separate databases. Clear and precise naming
of the associated databases is recommended.

RateManager and IBFA must run on a Windows Server machine. No other operating system will be
required. RateManager will be loaded in one environment only.

THE SETUP

1. All three application machines would create the same subscriber ID. The subscriber ID must be
uniform across all environments.

2. In the Development environment:
a. RateManager and IBFA/SR-WIN would be located on the same Windows machine.
b. OBI Publisher is installed for reports to be created.
c. On the IBFA/SR-WIN for this environment, three database connections would be created
and two logical environments would be created.
d. Two databases would be restored to a separate SQL Server machine.

3. Inthe QA environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. OBI Publisher is installed for reports to be created.
c. The Oracle client would be run.
d. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
e. One database would be restored to a separate Oracle DB.

4. Inthe Production environment:
a. IBFA/SR-WIN would be located on a Windows machine.
b. OBI Publisher is installed for reports to be created.
c. The Oracle client would be run.
d. On the IBFA/SR-WIN for this environment, one logical environment and one virtual file
server would be created.
e. One database would be restored to a separate Oracle DB.

1. The Oracle Server:
a. Requires that the Oracle DBA run the DDLs.
b. Requires that the Oracle DBA create a DT table for each line of business in each of the
two database created. The subscriber ID and line of business number will be required.

This is a basic Windows setup with the addition of an Oracle database. You can add another environment

if necessary. For example, if you wanted to create a training environment or a second level of testing, you
could add these environments in where you wanted.
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Example

IBRU Installation/Setup — Windows Incorporating an Oracle DB

Development saL QA G Production
Windows Windows Windows
Rating and Rules i ) . .
Aﬁlhnring Ze&_u'[r,e; Test Rating DE for SRPs Production Rating
TR Lot RUN: INSTALL:
'E’,:.: IBFA, DOLe IBFA
OBl Publisher OBl Publisher OBl Publisher
CREATE RESTORE:
SUBSCRIBER RUN: eRElE RUN:
Must be the same IB_CLIENT
in all ervironments security Cracle Cliant Ll tati-lgfﬂa EE Oracle Client
ADD RESTORE: CREATE CREATE
DB Connecticns: SUBSCRIBER SUBSCRIEER
RM hust be the same Must be the same
Controller Rating/Rules in all environments CREATE: in all envircnments
Security —
REM SR -the
IBSR DB for QA .
CREATE: CREATE:
) Logical
CREATE: Logical . Ervironments:
Environments:
Envﬁlr[:alnts- SR - to identify the (g SRI D—c;ﬂﬁéiegftmm
' location of the Products |
jocal SRPs and raduction - the local RPs and
RM —to handle the 0A IBSR DB IBSR DE for the Production
testing/rating. & Praduction IBSR DB.
QA_SR - This o o
environment
contains the full
packages to be Ergm= CREATE:
consumed by A .
\___/"—'_-“‘ " VFs:
Tothe QA_SR
environment on en:i?;lrrﬁ;l?un
the Devek_:pment the QA machine
machine
PURPOSE For
setting up this
Physical
Environment
PURPOSE For
S0L Server is m‘gzg '-I'P ‘I’“S
required for RM and yslcal
::It?rfgoﬁs ch?sr IBe_qCLIENT. The S0L Environment PURPOSE For PURPOSE For
Physical Server should be on i . ) setting up this setting up this
Environment a separate machine. This emaronment is Physical Physical
These DBs will for (real-time) Environment Environment
. . oduction rating.
Th t connect to the pr
is fcli tahn; I:eosr:inl:; I::f Development When users send The Oracle DB will This environment Is far
packages (SRPs) anviranment or the rate requests through hald the SRPs for the creation of rating
' emvironment that the system, this is the the QA and programs and
contains environment that will Production management of the
RateManzger. do the rating. environment. SRPs..
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INSTALLATION OF ORACLE CLIENT

The additional step of running the Oracle Client is described here. This can be performed as Step 10 in
the SoftRater Node Installation.

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.

Before proceeding, please have ready:
e The LOBs you want to use.

e Your subscriber ID

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

1. Run the Oracle Client. On the machine where you want to connect an Oracle database. For
example, if you want your QA and Production environments to run on an Oracle database, you
will need to run the Oracle client on each machine. New folders will be created. Locate file
Insbridge/SoftRater/DDL/Oracle. The DDLs will need to be moved to your Oracle database or you
will need to pass them over to your Oracle DBA. If you are unsure of a what actions you can take,
please consult with your database administrator.

2. On your Oracle database, run all DDLs.
3. On your Oracle database, you will need to run a DT table for each LOB.

4. After all DT tables have been created, please make note of:
e Schema
e Instance
e User name
e Password

This information will need to be passed along to the IBRU installer. This information is needed to
create a logical environment.
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RUNNING THE ORACLE CLIENT

For a 64-bit environment, please make sure you have the 64-bit Oracle Client.

[ oracle Client [_ (O] x|
(;(_:;v | - Downloads ~ Insbridge = 4.0.1-insbridge-IBRU - Oracle Clisnt - - [EJ ISearch @J
File Edit ‘iew Tools Help
Organize ¥ 155 Wiews l@l
Favorits Links Mame = |-| Date modified |v| Type |v| Size |v| Tags |-|
doc 8/31)2010 10:39,.. File Folder
[/ pocuments instal &131/2010 10:37...  File Falder
FE Pictures rEspOnse 81312010 10:37...  File Folder
I Music &31J2010 10:35...  File Folder
Mare s E;setup Flz4jz008 ::25 PM  Application 328 KE
o SELLD 1102712007 12:4,,, Configuration Se... 1KB
Falders w | welcome 3172009 4:08 PM HTML Daocument 4 KB
=l m Downloads ;I
= | Insbridge (i
4.0, 1-insbridge-doc
= 4.0.1-insbridge-IBRL
Databases
IEY_IES Users
Oracle BI Publisher
O _lient
Misc Downloads
o100
FE- Favoarites
[ Links
r[} Music
FE Pictures
m Saved Games
PB Searches
rﬁ Videos
Public
[+ 18 Computer LI

Figure 64 Locating the Oracle Client for 64-bit Installs

1. Inthe 4.0.1-insbridge-IBRU folder, locate the Oracle Client folder.

2. Select the setup application. The Oracle client installation will begin.
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~#fl Dracle Universal Installer: Select Installation Type

ORACLE 11g

DATAB&SE

Select Installation Type
Oracle Client11.1.0.7.0

What type of installati

Figure 65 Running the Oracle Client

5. Select RUNTIME as the Installation Type.
6. Click NEXT.

7. For the Summary — Inside Oracle Providers for .NET, the Oracle Client, you must use a LOCAL
DRIVE, i.e. C:\app\oracle-insbridge.

8. Click NEXT.

9. You can leave the defaults and INSTALL.
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LOCATION OF DDL DIRECTORY

If a database table needs to be added in SoftRater for Oracle, the DDLs are located in the IBFA
Installation Directory under the SoftRater/DDL folder. l.e. [INSTALL_DIR]/Insbridge/SoftRater/DDL. This
information may be needed if you are attempting to add an LOB and receive missing table errors.
Creating tables in Oracle should be performed by a qualified DBA.

ORACLE DATABASE SETUP

Oracle database files are packaged in the install. The IBSR_TEMPLATE file is located in the
Databases—>Oracle—> SoftRater folder. The file name is usp_IBSR _v03.12.0.oracle.

IMPORTANT: Itis strongly recommended that any database modification be performed by a qualified
database administrator (DBA). The database setup procedures and tasks require the skill
set of a database administrator. If you are not a database administrator, please stop.
Improper setup may result in unwelcome changes to the database. Please consult with a
qualified database administrator before proceeding.

These instructions are high level and require that the setup person be a DBA.

1. You will need to create the database. Oracle Insurance does not have specific requirements,
whatever requirements are deemed necessary by your company’s internal standards will work. It
is recommended that you included the version number or environment name if you are planning
on creating more than one instance.

Have this information ready:

e The LOBs that your company uses. You will need the ID number for each LOB.
e Your customer number.
o Location of the Insbridge files.

a) Create default tablespace for the Soft Rater database.

o If a database table needs to be added, the DDLs are located in the IBFA Installation
Directory under the SoftRater/DDL folder. |.e.
[INSTALL_DIR}/Insbridge/SoftRater/DDL. See Location of DDL Directory.

e You will have to replace the TABLESPACE name in the scripts with the tablespace
name you used when you created the database.

e Onthe DT tables, you will need to create one for every LOB. An example of the
format is in the comments of the script. It requires the LOB ID number and the
customer number.

b) Create user IBSR and assign basic connect and resource grants.
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Using a DB2 Database

A DB2 database may also be used. To obtain the DB2 client, please visit the IBM website and download
the Client for the version you have.

If a database table needs to be added in SoftRater for DB2, the DDLs are located in the IBFA Installation
Directory under the SoftRater/DDL folder. l.e. [INSTALL_DIR]/Insbridge/SoftRater/DDL. This information
may be needed if you are attempting to add an LOB and receive missing table errors. Creating tables in

DB2 should be performed by a qualified DBA.
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Chapter 6

SOFTRATER INSTALLATION — JAVA

A Windows/JAVA/Oracle Database Environment Example:

IBRU Installation/Setup — Windows/JAVA Incorporating an Oracle DB

This envirenment is for
the creation of rating
programs and
management of the
SRPs..

|B_CLIENT. The SQL

Server should be on

a separate machine.
These DBs will
connect to the
Development

amvirohment or the
environment that
containg

RateManager.

The Oracle DB will
hold the SRPs for
the QA and
Production
anvironment.

This environment
is for the testing of
packages (SRPs).

Development saL Tl QA Production
Windows Java Java
Rating and Rules . .
Authoring %a'_-"ﬁeg DB for SRPs Test Rating Production Rating
INSTALL: .
RUN: INSTALL: INSTALL:
IBFA
RM DDLs BSS IBSS
OBl Publisher
RUN: CREATE:
Oracle diant DT table for each CEsaE CEsaE
e ical Logical
Environments: Environments:
CREATE SR - to identify Froduction - to
SUBSCRIBER L Jeixi=
IBSR DB and identify the IBSR
location. DB and location.
ADD
DE Connections: \H/-n-\ \H/_n-\
Contraller RESTORE:
Security
RM IB_CLIENT
security
CREATE:
RESTORE:
Lagical
Envircnments: (=]
Rating/Rules
RM — to handle
testing/rating.
QA_SR - This CREATE:
emviranment
contains the full SR - the
packages to be IBSR DB for QA
loaded to the QA
DB.
Production SR — CREATE:
This environment
contains the full Production - the
packages to be IBSR DB_ far
loaded to the Production
Production DB.
\.._./_‘-\ PURFPOSE For
setting up this
Physical
PURPOSE Faor Environment PURPOSE For PURPOSE For PURPOSE For
setting up this setting up this setting up this setting up this
Physical S0L Server is Physical Physical Physical
Environment required for RM and Enviranment Enviranment Environment

This environment is
for (reaklime)
production rating.
When users send
rate requests through
the system, this is the
emvironment that will
do the rating.
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The Windows/Java environment utilizing an Oracle database example will displayed by machine and
contains 3 application servers and 2 database servers. There are still three environments; development,
QA and Production. The Oracle database server will contain two separate databases. Clear and precise
naming of the associated databases is recommended.

SoftRater can be run on a non-Windows machine if a compatible application server platform such as
WebLogic, WebSphere, or JBoss is running as well. If a non-Windows machine is used for SoftRater, you
will need to download a Java version of SoftRater from E-Delivery. The Java version of SoftRater will
need to be loaded onto the machine with the compatible application server platform.

The Oracle database can be setup after the subscriber has been created and the lines of business have
been selected. You will need this information to complete the Oracle database setup.

THE SETUP

1. The Development environment:

a.

oo

f.

g.

Contains one Windows application server and one separate SQL Server
database.

RateManager and IBFA/SR-WIN would be located on the same Windows
machine. RateManager and IBFA must run on a Windows Server machine.

OBI Publisher is installed for reports to be created.

The subscriber ID would be created here.

On the IBFA/SR-WIN for this environment, three database connections would be
created and three logical environments would be created.

The Oracle client would be run on the Windows machine.

Two databases would be restored to the SQL Server machine.

2. The QA environment:

a.

b.
c.

d.

Contains one JAVA application server with WebLogic, WebSphere or JBoss
installed and running. There is one separate Oracle database server that will be
shared between QA and Production.

IBSS/SR-JAVA would be loaded on the JAVA machine.

On the IBSS/SR-JAVA for this environment, one logical environment would be
created.

One QA database would be created on the Oracle machine.

3. The Production environment:

a.

b.
c.

d.

Contains one JAVA application server with WebLogic, WebSphere or JBoss
installed and running. There is one separate Oracle database server that will be
shared between QA and Production.

IBSS/SR-JAVA would be loaded on the JAVA machine.

On the IBSS/SR-JAVA for this environment, one logical environment would be
created.

One PRODUCTION database would be created on the Oracle machine.

4. The Oracle Server:

a.
b.

Requires that the Oracle DBA run the DDLs.

Requires that the Oracle DBA create a DT table for each line of business in each
of the two database created. The subscriber ID and line of business number will
be required
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This is a basic Windows/Java utilizing an Oracle database setup. It is possible to create more
than three environments or use fewer than three. There are many combinations of platforms,
databases and environments that can be used. Please contact your Insbridge representative for
more information on the configuration that you would like to have.

TO INSTALL INSBRIDGE SOFTRATER SERVER

e See Installing SoftRater for WebSphere
o See Installing SoftRater for WebLogic
o See Installing SoftRater for JBoss

CONFIGURING INSBRIDGE SOFTRATER SERVER

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse
to the following location, replacing SERVERNAME with the actual server name and PORT# with
the designated port:

http://SERVERNAME:PORT#/IBSS/

ORAC I_E‘ Insurance Insbridge SoftRater Server - Weblogic

SoftRater Administrator # Select an action to perform from the left pane.

® Resst Environments

® Submit InsBridge (el

& Submit Custom {xmil}

# Program Cache
®  Get Version

® st Config Path
® Gst Sample Files

®  Set WSDL (url)

o Get WSDL (url)

® Home

Figure 66 IBSS Home

NOTE: If you have renamed the databases, please make note of the new names.
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NOTE: Your subscriber should have been setup with your RateManager environment.

The Environment Setup section allows you to configure rating environments. An environment is a
pointer to a location where SoftRater Packages (SRP’s) are stored and loaded. There is no limit
to the number of environments you may have. To navigate to the Environment Setup page, select
the Environment Setup link available from the menu tree on the SoftRater page. Required fields
will be marked with an asterisk (*)

Browse to SoftRater Version 3>Environment Setup.

* Environment Setup

Status:

SELECT ENVIRONMENT | = Add Mew Environment << %

Envircnment Mame® |SUﬁ:Rater | Company Id*
Database Server® [10.200.10.200 | Port® queryBock| |
Database Name* |IESR | Schema nama** I:I

Catzbass User 1d* |sa |
Distabase Password® |IIIIIIIIIII |
Provider Typs M5 5QL Server ¥

Database Typs SoftRater hd

Data Dir |

* Fields are required.
** Fields required for an Orade DB connection.

Save Exit Test Connection! Delete!

Figure 67 Create a Rating Environment

To Create/Edit an Environment

1. To create a new environment, use the drop down text box next to SELECT
ENVIRONMENT and select >> Add New Environment <<. If you are editing an existing
environment, select the name from the drop down text box. If the page does not
automatically refresh, click |al |,

2. When the page refreshes, enter the following information:

Select Environment;

There are three types of Logical Environments:
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e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.
Database Name: The name of the database that packages are loaded to.

Database User Id: Username to access the database. This information may be
obtained form the Oracle DBA.

Database Password: Password to access the database. This information may
be obtained form the Oracle DBA.

Provider Type: The provider of the database. Options are DB2, DB2(AS400),
ORACLE and MS SQL SERVER.

Database Type: The type of database being accessed. Options are SoftRater
and RateManager.

Data Dir: The location of the SoftRater Packages (SRP’s).
Company Id: Your Company’s subscriber ID.

Port: Listening port to the target Database Management System.

Query Block: (Optional) For certain Database Management Systems (DBMS),
system batch query optimization is required for performance and/or because of
limits on/in the system. This value will control the maximum number of batch
query operations that can be submitted to the target DBMS in any one
transaction. It is known that for certain DB2 platform versions a value of 31 is
required because of a hard software limit.

Schema Name: The name of the schema that defines the structure of the
database. This information may be obtained from the Oracle DBA.

3. When you are finished entering information, click Save. The environment will be saved
and the Status field will update.

4. Before you can use the new or edited environment for rating, you will need to reload the
configuration XML file. This is done by resetting the environments.

For more information on working with IBSS, please see the IBSS User Guide.
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Chapter 7

UPDATING AN INSBRIDGE APPLICATION

An update to the system can be run from the same installer. Unzip the IBRU folder on the
machine where the IBRU system (IBFA and RateManager) is currently installed. Click the
installer.

During the installation, the installation program requires the installer have administrator rights on
the machine where the install is occurring. Please close all open applications and run the Oracle
Insurance — Insbridge Rating and Underwriting file.

A Welcome screen will be displayed.

i'.g!,'J Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B |

4 Oracle Insurance Insbridge Rating and Underwriting

[tiz strongly recommended that you exit all Windows programs befare running this setup program.

Click Cancel to quit the setup pragram, then cloze any programs pou bave running. Click Mest to
continue the installation.

WARMIMG: This progran is protected by copyright law and international treaties.

|Inautharized repraduction or diztribution of this pragram, or any portian of i, may result in zevere civil
and criminal penakies, and will be prozecuted to the magimum extent pozzible under law.

ORACLE’

INSURANCE

Cancel |

Figure 68 Installing Insbridge

1. Click on Next to continue. The destination path will be displayed next. This is an information
only screen. No changes will be allowed.
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i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The ‘wize |nstallation ‘wizard will inztall the files for Oracle Insurance - Ingbridge B ating
and Undemariting in the fallowing folder.

Toinztall into & different folder, click the Browse button, and zelect anather folder.
Y'ou can choose not to inztall Oracle Insurance - Insbridge B ating and Undenariting by
clicking Cancel bo exit the YWize Installation ‘wizard,

Dreztination Folder
{E:HF‘HDGH.&M FILESAORACLENGEUSMSBRIDGE

Wize Installation ‘fizard [R]

Cancel |

¢ Back

Figure 69 Destination Location for Update

2. The next screen is the Logon Information screen. Please use the Insbridge user account
information that you set up earlier.

i'él Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B |

Logon Information DRACLE‘

The following logon infarmation is uzed by Insbridge. INSURANCE

Specify a uzer account ba be uzed by the application, either far running a service or for
logging onto ather zervers. Use the Browse button to choose wsers from your netwark.
For domainz, user names muzt be in the format of DOMAIRY ] zerM ame.

I=er Marne: IInsbridge Browsze... |

Faszword: Ixxxxxxxx,1

Create Mew Uszer... |

Wize Inztallation Wwizard [R]

< Back | Mewt = I Cancel

Figure 70 Entering User Information for Insbridge
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3. Click Next to continue.

4. The next screen will list the applications to be installed. To expand the options and view
details, click on the downward arrow. All features are checked for installation. RateManager
is the only one that you will be allowed to not install.

i'g‘ Oracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= B3 |

Select Features 'DRACLE

Pleaze select which features you would like to install,
Y INSURANCE

Inzbridge F ating & Undernwriting
.= = | Ratehanager

Feature Description:

Oracle Insurance Inzbridge B ating and

I Indenariting iz a *Web-based rating, rules, and
i i =0 = | Oracle Bl Publizher Repaorts urdenaniting spstenm,

=

Thiz feature will be installed on the local hard
drive.

Thiz feature requires OKE on vour hard diive. [t
has 2 of 2 subfeatures selected. The subfeat..

Current lacation:
C:\PROGRAR FILESAORACLEMGEUMMNSERIDGEY

YWize [nstallation wizard [F]

Digk. Cogt Bezet ¢ Back | Mest > I Cancel

5. Click Next to continue.
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ji& Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |

Ready to Install the Application ORACLE

Click Mest to beqin inztallation. INSURANCE

Click the Back buttan to reenter the installation infarmation ar click Cancel to exit
the wizard.

Wize Inztallation YWizard [R]

Cancel |

6. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back
to check the options you want to install. A progress screen will display your progress.

i'g!,'J Oracle Insurance - Insbridge Rating and Underwriting Setup M=l B3 |

Updating System ORACLE

The features you selected are currently being installed.
Y v hEng INSURANCE

Y alidating install...

YWize [ngtallation wizard [R]
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7. When complete, a ReadMe Information screen will be displayed.

fiz Dracle Insurance - Insbridge Rating and Underwriting 4.1.0 Setup M= Eq |
Readme Information D.RACLE'
|nzbridge has been successfully inztalled. INSURANCE
Microsoft Windows 2003,/2008 Server =

A full installation of Microsoft Server 20032008 is required. The following
configuration assumes that the administrator of the senver to be generally
familiar with managing a Windows server.

Internet Information Services {lI5)

The InsBridge Rating and Underwriting System is a web based application and
requires IS to be installed before installation to facilitate the default web virtual
directaries creations.

The subcomponents of IS needed by IBRL

. Commaon Files
. Documentation
. Internet Information Serices Snap-In hd

YWize [nstallation Wizard®

< Back

8. Click Finish.

NOTE: Any Insbridge services will be stopped during the update.

UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This
is the recommended way to update these databases. The SoftRater database will need to be
updated manually on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: If you need to go from an older version, such as 3.9, you will have to enter RateManager
and run the IBRM and IB_CLIENT update scripts in sequential order from there. You
must be a DB Owner to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the IBRU
Databases for more information.
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UPDATING AN ORACLE DATABASE

On the Windows machine that hosts the Oracle database connection, run the Oracle Client.exe.

Select your company name underneath Config on the left hand side to enter the configuration
information for the environment you want to update.

ORACLE. Insurance Insbridge Framework Administrator

B3 Insbridge
=-C3 softRater

Add Environment
Add, edit, or remove environments from your Explorer configuration.

Config

Envircnments

~L softDats NAME - DESCRIPTION

L services # RM Default - Development

F-J Logs # QualityControl - Quality Assurance
H-C3 Security # SR RM - Production

Figure 71 Obtaining Environment Information

/= Framework Administrator (WINAPPOO1) - Windows Internet Explorer

@ + [ ] hetpsfiLocshostiErajdsfaut sspx]

."4‘ ‘3 |E ‘lee Sesrch

© Fle Edt Wew Favorites Tools Help

- - v [hpage - {FTook -

v & [EFramewnrkAdm\mstratur(WINAPFDDl) [ 1

ORACLE. Insurance Insbridge Framework Administrator
E-C3 Insbridge

I
&2 st —

3 Engine A
Configuration DEVELOPMENT

Environment(s) you may use for rposes. Selecting an below will denote it as the default.

Version 04.01.00 (x86)

Environments

- Services Environment: RM_Default @
e scag o
3 security DB Server: WINAPPOOS i
425 Softlibraries DB ServerType: SQLServer > 1
@) rep DB Catalog: IBRM_Alamere
DB CatalogType: RateManager v
DB Query Buffer:
DB Tablespace:
DB Schema: A
DB User: sa
DB Password: ansrsane
Engine Type: Windows v
Engine Lacation: LOCALHOST
Engie et

Environment(s) you may use for quality assurance purposes. Selecting an environment below wil denote it as the default.

Dong.

Environment:

Package Location:

DB Server:
DB ServerType:
DB Catalog:

DB CatalogType:
DB Query Buffer:

QualityControl
C:\Insbridge\SRP

WINAPPOO3

sQLServer ~|
IB5R_Alamere

SoftRater v

<
Test Environment....

R 100% - -

Figure 72 Editing Environment
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Only the information required for this connection is: Environment, DB Server, DB Server Type,
DB Catalog, DB Catalog Type, DB Schema, DB User, DB Password, Engine Type and Engine
Location. The Package Location, DB Query Buffer, DB Tablespace and Engine EnvDef can

remain blank or filled out as needed.

For each environment, you can set up the following information:

Previous Value

Updated Value

the packages should be stored. Click Test
Environment to run a process to validate the
permissions on the directory and certify any
packages in the directory. In order for the
Framework Administrator to successfully
manipulate packages in the location, it must
have full control of the directory.

Environment: The name of the environment. No change.
Selecting the radio button next to an

environment's name will set it up as the default

environment.

Package Location: Physical location of where No Change.

DB Server: The name of the server that houses
the database that packages will be loaded to.

DB Server: The name of the server that
houses the database that packages will be
loaded to. For DB2 servers, this is the DB2
Registered Alias Name. For Oracle servers,
this is the server name; either IP or DNS will
work. The Database listener port number
will also need to be appended to the server
name if it is something other than the
default port.

The format for this is as follows: [SERVER
NAME]:[PORT NUMBER]

DB Server Type: The type of server that
houses the database. Currently, RateManager
and SoftRater support SQL Server, Oracle and
DB2.

No Change.

DB Catalog: The name of the catalog in the
database. Not required for SQL Server.

DB Catalog: The name of the catalog in the
database. For DB2 servers, this is the
System DSN Name. For Oracle servers, this
is the instance.

DB Catalog Type: The type of catalog in the
database. The types available are:
RateManager, SoftRater and Other. If you are
using a SQL Server, you can choose either
RateManager or SoftRater.

DB Catalog Type: The type of catalog in
the database. The types available are:
RateManager, SoftRater and Other. If you
are using a SQL Server, you can choose
either RateManager or SoftRater. If you are
using an Oracle or DB2 database, you will
need to choose Other and enter the
remaining information.
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Previous Value

Updated Value

*DB Query Buffer: For certain Database
Management Systems (DBMS), system batch
query optimization is required for performance
and/or because of limits on/in the system. This
value will control the maximum number of batch
query operations that can be submitted to the
target DBMS in any one transaction. It is known
that for certain DB2 platform versions a value of
31 is required because of a hard software limit.

No Change.

*DB Tablespace: The name of the table space
in the database.

No longer required.

*DB Schema: The name of the schema that
defines the structure of the database.

*DB Schema: The name of the schema that
defines the structure of the database. This
information may be obtained from the
Oracle DBA.

DB User: Username to access the database.

DB User: Username to access the
database. This information may be obtained
from the Oracle DBA.

DB Password: Password to access the
database.

DB Password: Password to access the
database. This information may be obtained
from the Oracle DBA.

Engine Type: The type of SoftRater engine that
is used. The available options are: SoftRater for
Windows, SoftRater for WebSphere, SoftRater
for WebLogic, or SoftRater for JBoss.

No Change.

Engine Location: The location of the SoftRater
engine. If the engine is local to the Framework
Administrator (i.e. located on the same server),
leave this field as LOCALHOST. If the engine is
located on a different server, enter the name in
the box.

No Change.

Engine EnvDef: This field should remain blank,
unless the engine is located on a different
server. If the Engine Location is set to
LOCALHOST, leave this field blank. If the
Engine Location is not LOCALHOST, this
should match the name of the environment on
the remote server.

No Change.

NOTE: If you are using an Oracle or DB2 server, the options and requirement will be different.
Please see the Insbridge IBFA User Manual (Located in the User Guides directory) for

more information.
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Chapter 8
WORKING WITH RATEMANAGER FOR THE FIRST TIME

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation
server is the server where RateManager was installed.

This will place you on the RateManager login screen.
1. To login for the first time, select your company from the drop down menu.
2. The user name will be demo.
3. The password will be password.

To change your password, go to Administration>»Change Password.

For more on user management, please see the RateManager User Guide.

NOTE: If you log into RateManager and Tools is the only option, you must perform a database
update.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in
IBFA.

RUNNING DATABASE UPDATES IN RATEMANAGER

If you log into RateManager and Tools is the only option, you must perform a database update.
After you perform the database updates, to view all menu options, click File>Reload.

/= Oracle Insurance Insbridge RateManager 4.01 - Windows Interns

ORACLE" Insurance Insbridge RateManager
File Tools | Help

A Databass » B  Backups

E] |pdates

Figure 73 Tool Mandatory Update

Hom

On the DB Updates screen, the current version will be highlighted and the status will be Current.
The updates below the current version will be grayed out. These updates cannot be run again.
You will receive an error message if you attempt to run a lower version update. Any version
update above the current version will also be grayed out but will be available for executing.
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http://installationservername/RM

Updates have to be installed sequentially, meaning if you are on Version 3.9, you must run the
3.10 update, then the 3.11 update, the 3.12 update, the 3.13 update and finally the 04.01.00
update. If you attempt to run an update that is more than one level above the current version, you
will receive an error message.

1. Navigate to the Tools>Database->Updates.

2. The Updates tab will be displayed. Select the database you want to view from the Show
updates for drop down. The database updates for your selection will be listed. The last
column, the Status column, will show you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

File  Tools Help

Home DB Updates ®
(& DB Updates
.!E,, Execute Update Script J:E Open Update Script E Save Update Script to File E’ﬂ Refresh
Show updates for:| IBRM B
—Cnpt Felease Date Database Status
vO4.01.0.00 11/15/2010 IBRM
vO<4.00.1.00 6/15/2010 IBRM
vO4.00.0.00 3/10/2010 IBRM
v03.13.0.00 12/15/2009 IBRM
03.12.0.00 4/30/2009 IBR
03.11.0.00 11/320/2008 IBER
03.10.0.00 8/31/2008 IBR
032.9.0.00 5/19/2008 IER.
03.8.0.00 &/ 72007 IBER
03.7.0.00 7/28/2006 IBR

Figure 74 Available Updates

3. There are two ways to execute an update:
a. Directly in RateManager
b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting
the update showing Current. This will assure that the database showing as Current will have all
possible updates.

1. Highlight the update you want to run.
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2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.
3. Click OK to run the update or Cancel to return to the previous screen.

4. Do this for both the IBRM database and the IB_CLIENT database.

A Confirm Update -- Webpage Dialog @

™ Are you sure you want to replace the
_!_/l current database's contents with the
- selected release script on disk?

2 Ok | & cancel |

Figure 75 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be
displayed if you execute scripts in the wrong order. You must know the name of the databases
you are updating. Please see Manual Updates to the IBRU Database.

UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager.
Changes will take place after the user sessions have been ended. If web settings are changed
while the users are inside the module, the change will not be visible to them. Prior to users
accessing RateManager for the first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools=>Preferences.

Tools | Help
@J Manage Lines
O Audit
% Import Pragrams
@ Security r
B Database 3
Change Password
37 Preferences
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2. This will open the Preferences window. Select Web Settings.

Preferences
—I-Settings
H ~
—-User =
T g Web Settings
i -Home Page
= Adrninistratar
] i Insbridge Configiml Path:  [C:\PROGRAM FILES\ORACLE\IGEU\INSERIDGE\FRAMEWORK]
L-\Web Settings
Messaging Server : ||Dca|hgst | {Secure Channel) IF
‘SoftRater Server : ||Dca|hgst | {Secure Channel) F
Backup Share Folder | |
Location:

Use Insbridge Com+

= W
Admin: Trus

Enforce Release Packaging: | False %

Batch Package Threads:

Minimum Login User ID
Length: El

el o
Show Owverride Date Mask: | Trus | %
Allow Data Type Change: | True |
Inactive Session Time Out: E (hrs)

Bstch Results with Newline: | Fale

‘Online Help Server: |loca|hc\st |
My Recent List:
Default Prosey Script TR

ion: |http.,-,- wipadvpad.dat |
Change Control: Off | »

? Save | @ close |

Figure 76 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back
and edit lat a later time. It is recommended that you update the ONLINE HELP Server
immediately.

4. When you are finished, click SAVE to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change
this path if you have changed the path in IBFA. Please contact Insbridge support for further
information. It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you
have an especially large batch to run and you want to batch to a different server, you will have to
change server locations here. Unless necessary, it is strongly recommended that you leave the
default.
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SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the
backup file. If the location is local, you will use a local path. If the location is not local, you must
be a disk admin to change.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full)
package. False is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user
wants to create a SoftRater (full) package in the Program Explorer module, a release must be
created in the Releases area first. This release must have the program added to it and be
unlocked. When the user creates the SoftRater package in Program Explorer, they will have the
option to select the Release they want this package to be placed into. If there is no release, or no
release that contains that program and is unlocked, then the user will be able to do RateManager
(local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to
finish faster by splitting the process into smaller processes that run quasi-simultaneously. On
multiprocessor systems, using multiple threads enables the operating system to assign the
threads to different processors.

In addition, the Framework Administrator also enables you to change the administrator email
address for each client. When a process fails, an email will be sent to the person who initiated the
process, as well as to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even
a system crash. If you are unsure of how many threads to use, set the number to 1.
For single processor systems, Oracle Insurance recommends a maximum of 2
threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 116



User must change password

This where you set the number of days before a user is required to change his/her password.
This setting will only be active when you elect to have users change their password on the user
setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not
enabled, this field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and
string) data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or
input. Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the
system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting
will place a carriage return between result files. A False setting will result in one continuous string
without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where
RateManager currently resides. Either a server name or an IP address can be entered here. If
needed, you can change the name of the server. For example, if the machine name is not the
same as the host name, you may need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and
justification to any element or program when it is revisioned. If change control is off, the option will
not be presented.
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Chapter 9

MANUAL UPDATES TO THE IBRU DATABASES

In the RateManager, Security, and SoftRater Database folders you will find the current database
scripts. The RateManager and Security database update scripts will take previous IBRM and
IB_CLIENT databases from version 3.13 to version 04.01.00 only. To go from a lower version
up to 04.01.00, you must enter RateManager.

The IBSR database update will need to be run once, regardless of version, in the corresponding
database. If you are updating from a release previous to 3.13, please see UPGRADE NOTICE on
page 127.

NOTE: Oracle database updates must be performed directly on the Oracle database by an
Oracle DBA. Improper scripts updates can result in database failures. Oracle database
updates are not available on RateManager.

TO PERFORM DATABASE UPDATES FROM RATEMANAGER

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager. If the administrator has DB User privileges and is the DB Owner of the database
as well as the disk administrator, database updates can be done on the
Tools>Database>Updates tab. If these privileges are not in place, an error message will be
displayed. See Running Database Updates in RateManager for instructions.

NOTE: If you need to go from an older version, such as 3.11, it is strongly recommended that
you enter RateManager and run the 3.12, 3.13, 4.0, 4.0.1 and 4.1 update scripts
successively from there.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates using Query Analyzer.

1. In RateManager, highlight the update you want to run. If you are going from a much lower
version of RateManager, you may have to save multiple files for each database.

2. Click Save Update Script to File. Your computers dialogue box will be displayed. Save
the file to a location of your choice. For IBRM scripts, it is recommended that you rename
the file to usp_IBRM_RO(version number).sql. For example the V3.12 update would be:
usp_IBRM_R0312.00.sql. For IB_CLIENT scripts, it is recommended that you rename the
file to usp_IB_CLIENT_RO(version number).sqgl. For example the V3.12 update would be:
usp_IB_CLIENT_R0312.00.sql.

3. To view the update script prior to execution, highlight the update you want to view. Click
Open Update Script. The update script will be displayed in a separate screen.
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2 IBRU : v04.00.0.00 -- Webpage Dialog

qadose

PRINT ' e e R e e e e AR R AEELLECEEECACRCRRRRRLALLECEERRRRACRRRRRRRE
Eletcclelelelel e et el el el e e el e e el el el el el et el elel el et e el el el el el el e e el el el el el el el ettt el el el el et el e ettt el el e e
BEEEEEERERAAEEEECEEARRRRRERRRRRRR

FRINT ' THE WARNINGS BELOW ARE EXPECTED WARNINGS..... '

PRINT ' Cannot add rows to sysdepends for the current stored procedure becaunse it
depends on the missing object usp I RM SAVE COMPANY PATHS. The stored procedure

will =till be created.’

PRINT ' Cannot add rows to sysdepends for the current stored procedure becaunse it
depends on the missing object usp U RM UPDRTE CATEGORY PATHS. The stored procedure
will =till be created.’

PRINT ' Cannot add rows to sysdepends for the current stored procedure because it
depends on the missing object usp IDNX getCategoryProgramInputsSystemXML. The

stored procedure will still be created.'

PRINT ' Cannot add rows to sysdepends for the current stored procedure because it
depends on the missing object usp RM ITEM CHECEOUT. The =stored procedure will

ztill be created.’

PRINT ' Caution: Changing any part of an object name could break scripts and stored
procedures. The COLUMN was renamed to IMPORTED WVERSION.'

PRINT 'GEEEEEE R R e e e R AR R A EEEEEACRRECRRRRREAREEEEERRREARRARRRRRRER
B R A e AR R e R R A R A e AR EEARRREAEEEERRRRAREEERERRRRE
BEEEEEEEEEEEREERARRRARARLRRERRRRR

fewwas® Object; Table [dbo].[USER_PREFERENCES] Script Date: 07/09/2009 11:15:25
wEEER R

SET ANSI NULLS ©CN

GO

SET QUOTED IDENTIFIER ON

GO

IF MOT EXISTS (SELECT * FROM dbo.sysobjects WHERE id = OBJECT_ID(N® [dbo].
[USER_PREFERENCES] ') AND COBJECTPROPERTY (id, N'IsUserTable') = 1)

BEGIN

CREATE TABLE [dbo].[USER PREFERENCES] |

[USERID] [nchar] (100) NOT WULL,

[ITEMID] [int] IDENTITY(1,1) NOT NULL,

[NAME] [nvarchar] (256) NOT NULL,

[VALUE] [ntext] NULL,

[TYPE] [nchar] (100) NULL,

[DATETIMESTAMP] [datetime] NOT NULL CONSTRAINT
[DF USER PREFERENCES DateTimeStamp] DEFAULT (getdate()),

Srare oo s —
Figure 77 Script Viewer

4. If this is the script you want to run, open Query Analyzer in SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

5. Open up the DB script updates from the download file. You can open in any program
you want, such as Notepad. Begin with the next sequential update. For example, if you
are going from V3.11 to 04.01.00, open 3.12 first.
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R Microsoft SOL Server Management Studio H=

Filz | Edit WYiew Tools ‘Window Community Help

27 Connect Object Explorer. .. x| Sl Hd | BEBRE S,

¢ Disconnect Object Explorer

‘ Object Explorer Details | - X

Hew

4 Project... ChrShift+N |

open

Close:

Source Cantrol 3 [ Vigws

Exit

Save A

. Query with Current Connection  Ctrl+M

- MARY

\IB_CLIENT_MARY 8 Item(s)

Database Engine Query

¥ Analysis Services DMY Query

% Analysis Services XMLA Query |

Crl+shift+5

A
2
L
1y Analysis Services MDX Query
1
]
&

SQL Server Compact Edition Query

A Synanyms
|2 Yoy

o [ Programmability

[ Service Broker
[ Storage

[ TBRM_310_TEMPLATE [ security

Figure 78 Updating Database

10.

11.

12.

13.

14.

15.

16.

17.

18.

Select the database you want. In SQL Server Management Studio, create a new
Database Engine Query, File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.01.00 update. Then continue on to the next database.

For example, if you want to update the IBRM database in SQL Server, select the IBRM_
database. In SQL Server Management Studio, create a new Database Engine Query,
File>New—->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.01.00 update. Then continue
on to the next database.

For example, if you want to update the IB_CLIENT database in SQL Server, select the
IB_CLIENT database. In SQL Server Management Studio, create a new Database
Engine Query, File>New->Database Engine Query.

The query screen will be displayed on the right hand side.

Copy the first update from Notepad and paste onto the query screen.

Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. Run each update until you run the 04.01.00 update. Then continue

on to the next database.

After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed

The updates are now properly applied and users can log back in to the system.
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UPDATING THE SOFTRATER DATABASE FROM A LOWER
VERSION

For SQL Server Only: The only upgrade needed to perform for SoftRater is adding the new
stored procedures on all of the IBSR databases. This can be accomplished by opening Query
Analyzer and connecting to the IBSR database. Then run the included SQL script
usp_IBSR_v03.13.00sql available in the install download.

For an Oracle Database: Run the corresponding Oracle file.
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Chapter 10

WINDOWS 2003 SETTINGS AND PERMISSION NOTES

Microsoft .NET Framework

It is suggested that the Microsoft .NET Framework version 3.5 be installed prior to the Insbridge
Rating and Underwriting System install. .NET Framework version 3.5 can be obtained from
Microsoft's website or from using Microsoft's Windows Update.

We also highly recommend installing the .NET Framework after installing IIS in order to update all
the web applications to utilize the ASPNET system.

This can be doubled checked by:

Open Internet Service Manager and right click the Default Web Site.
Select Properties.

Select the Home Directory tab.

Click Configuration....

Scroll until you find the ASPNET extensions (.asax, aspx, .asmx, etc.).
To get a detailed look, select an extension and click Edit.

ok wN =

Default Web Site Properties 7 x|

T3 irtemet Infarmation services Directory Securty | HTTPHeaders | CustomErrors ASPNET

=94 PLTWINAPPODI, (ocal comy WebSke | Performance | ISAPIFiters  Home Directory | Documents

l _J Application Poals The content For this resource should come from:
[=_J Web Sites % A directory located on this computer
8 Default web Site
_J Web Service Extensior

" A share located on another computer
& redirection to a URL

\.M».‘ T

|Application Configuration | [nnﬁguratmn

Logal path;
I Script soure.
IV Read Mappings IOpt\or\sI Debugaing |
I write

I~ birectorytn [V Cache ISAPI extensions

Application sett pelication extensions

Extens... | Executable Path Werbs

Lashx CYWINDOWS|Microsaft, NET\Framew, . GET,HEA.._|
Starting pelnts Lasmx CAWIMDOWS|Microsoft NET{Framew. .. GET,HEA..
Jasp Co\WINDOWS!system32inetsryiaspdl  GET,HEA, .
Execute permis aspx  cAWINDOWS|Microsoft. NETIFramew. .. GET,HEA
Jaxd CHWINDOY z=== e

Application poo 1 Add/Edit Application Extension Mapping
add... £ Executable: |T\Framewmk\vznsu?zw\aspneusapmu Browse...
‘Wildcard application map;  EXtension: R

the

© llverbs

Application nay

£ Limit ko IGETJHEAD,POST,DEEUG

Move Up, Move [V Soript engine:

I werify that file exists ex |
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Figure 79 Installing .NET Framework
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If you don’t see any of the ASPNET extensions (.asax, aspx, .asmx, etc.) pointing to
%WINDIR%\Microsoft. NET\Framework\v2.0.50727\aspnet_isapi.dll, then the .NET framework
was probably installed prior to installation of IIS.

To install the ASPNET ISAPI extensions, use the aspnet_regiss.exe located in the
Framework\v2.0.50727 folder. If you want to upgrade all default web applications under IIS to use
the 2.0 framework ASPNET ISAPI, use the following syntax:

C:\WINNT\Microsoft .NET\Framework\v2.0.50727>aspnet_regiis.exe

Install this version of ASP.NET and update script maps at the [IS metabase root and for
all script maps below the root. Existing script maps of lower version are upgraded to this
version.

Please see page19 in regards to the permissions required by the local ASPNET user account.

Internet Information Services (IIS) 6.0

The Insbridge Rating and Underwriting System is a web based application and requires IIS to be
installed before the Insbridge Rating and Underwriting System installation to facilitate the default
web virtual directories creations.

The subcomponents of Application Server needed by the Insbridge Rating and Underwriting
System:

Application Server Console

ASP.NET

Enable network COM+ access

Internet Information Services (IIS)

- Common Files (default)

- SMTP Service — Although not required, the SMTP service will allow the Insbridge
Rating and Underwriting System to notify users via email when extended jobs have
been completed. If the SMTP service is located on a corporate network, then the
service must be properly configured for authorization to relay mail internally to a
smart host. Please check with your information services support group for proper
configuration.

- World Wide Web Service

= Active Server Pages
= World Wide Web Service

e Message Queuing

- Active Directory Integration (default)

- Common (default)

After installing 1IS and .NET 3.5, Active Server Pages and ASP.NET v2.0.xxxx must be
enabled in order for the IBRU applications to work.

1. Open Internet Information Services (1IS) Manager in the administration tools.

2. Select the Web Service Extensions on the left hand side and make sure they are
Allowed as shown below:
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Figure 80 Enabling Active Server Pages and ASP.NET v2.0

Message Queuing Services

The Insbridge Rating and Underwriting system utilizes the Microsoft Message Queuing Service
(MSMQ) for batching jobs and other types of extended functions. The Microsoft Messaging
Queuing Service can be configured for stand-alone operation without need to access any Active
Directory unless specified by your information support services. The Insbridge Rating and
Underwriting System utilizes by default private message queues that have no need for routing.
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Figure 81 Message Queuing Type

Oracle Insurance Insbridge Rating and Underwriting Installation and Upgrade Guide Page 124




Installing Java Runtime Environment for PDF creation

In order to create reports as PDF files from the RateManager web interface, the Java Runtime
Environment version 1.4 or above must be installed on the web server. The JRE can be
downloaded from the http://java.com/en/download/manual.jsp.

MDAC 2.8

If the Insbridge Rating and Underwriting application is split between a web server and a database
server, then Microsoft's Data access component version 2.8 needs to be installed on the web
front-end server. MDAC version 2.8 is included with Windows Server 2003.

Special Considerations for Windows Server 2003

Microsoft has identified some known issues with Windows Server 2003. Oracle Insurance is
aware that these issues may surface during the installation of Insbridge Rating and Underwriting
System, depending upon your network setup and choice of operating system. Oracle Insurance
offers the following solutions for known issues. Please discuss and involve your System
Administration Group or IT Department prior to making any change. The suggestions listed below
will allow the Insbridge Rating and Underwriting System to function in most environments. Oracle
Insurance makes no claim to knowing what effects these changes may have on other areas of
your network.

Prior to making any changes, please consult with your System Administration Group or IT

Department and Insbridge support.

FIPS Encryption

PROBLEM: A Windows Server 2003 server with an encryption level set to FIPS Compliant will
not allow Remote Assistance connections from a Windows XP box. When you try to connect, you
will receive an error message.

SUGGESTED SOLUTION: Disable the FIPS encryption.

There are two ways to enable the FIPS encryption level. If you have to disable the FIPS
encryption level for Terminal Services, you must do this by using the same method that you
originally used to enable the FIPS encryption level. *

Method 1

To disable the FIPS encryption level by changing the Encryption level setting in the RDP-
Tcp Properties dialog box, follow these steps:

1. Click Start, click Run, type tscc.msc in the Open box, and then click OK.
2.Click Connections, and then double-click RDP-Tcp in the right pane.

1 From Microsoft Knowledge Base Article #811770.
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3.In the Encryption level box, click to select a level of encryption other than FIPS
Compliant.

Note If the Encryption level setting is disabled when you try to change it, the system-wide
setting for System cryptography: Use FIPS compliant algorithms for
encryption, hashing, and signing has been enabled, and you must disable this
system-wide setting by using method 2.

Method 2

To use the Group Policy Object to disable FIPS data encryption system-wide, follow these steps:

1. Click Start, click Run, type gpedit.msc in the Open box, and then click OK.

2.Expand Computer Configuration, expand Windows Settings, expand Security
Settings, expand Local Policies, and then click Security Options.

3.In the right pane, double-click System cryptography: Use FIPS compliant
algorithms for encryption, hashing, and signing, click Disable, and then click
OK.

Note Encryption level settings in Terminal Server are unavailable when FIPS is enabled.

For more information, please visit http://support.microsoft.com/kb/811770.

Distributed Transaction Coordinator (DTC)

PROBLEM: Network DTC access is disabled by default in Windows Server 2003 server. If
network DTC access is not enabled, applications can only use transactions that are located on
the same box. If you want a client to access the server, you will receive an error message.

SUGGESTED SOLUTION: Enable DTC Access.

Please note that you must restart the server. ?

Steps to enable network DTC access

1. Click Start, point to Control Panel, and then click Add or Remove Programs.
2. Click Add/Remove Windows Components.

3. Select Application Server, and then click Details.

4.Select Enable network DTC access, and then click OK.

5. Click Next.

6. Click Finish.

7. Restart the computer.

If you are running Windows Server 2003 SP1, there are additional steps that must be taken.
Please see http://support.microsoft.com/kb/817064/en-us for more information.

2 From Microsoft Knowledge Base Article #817064.
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NOTICE

UPGRADE NOTICE

This notice is for customers currently running a SoftRater for Java engine Release 3.12 or lower.
This includes:

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
Necessary updates have been made to the SoftRater for Java engines. This includes:

o SoftRater for WebSphere has been updated to SOAP version 1.1.

o SoftRater for WebLogic has been updated to SOAP version 1.2.

o SoftRater for JBoss has been updated to SOAP version 1.2.
These changes mean that the WSDLs for the SoftRater for Java engines have been modified.
Updated WSDL documents will need to be incorporated into any client calling application that
communicates with SoftRater. If upgrades are done to the SoftRater for Java engines without
updating the calling applications, the calling application will fail.
Please update a test environment prior to deploying to production. Install the .EAR file in a

test environment to obtain the WSDL. Update your calling application and then test. When testing
is complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be
affected.

These updates are for the 3.13.5 and 4.01.00 release of SoftRater for Java engines only.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation
World Headquarters
500 Oracle Parkway
BeSCN,X\OOd Shores, CA 94065

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.
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